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GLOSSARY 
 

ACE Advanced Control Equipment 

AI Analog Input 

AO Analog Output 

AWG American Wire Gauge  

DCD Data Carrier Detect 

DFM Direct Frequency Modulation 

DI Digital (Discrete) Input 

DNP Distributed Network Protocol 

DO Digital (Discrete) Output 

DPSK Differential Phase Shift Keying 

EPP Environmentally Preferred Product 

ESD Electrostatic Discharge  

EU European Union 

FCC Federal Communication Commission 

FEP Front End Processor (MCP-M, MCP-T, or FIU) 

FET Field Effect Transistor 

FPGA Field Programmable Gate Array 

FSK Phase Shift Keying 

FIU Field Interface Unit 

GND Ground 

GPRS General Packet Radio Service 

GPS Global Positioning Satellite 

GSM Global System for Mobile Communications  

HW Hardware 

IEC International Electrotechnical Commission 

IO (I/O) Inputs Outputs 

IP Internet Protocol 

IPGW MOSCAD IP gateway 

LAN Local Area Network  

LED Light Emitting Diode 

MCC  Master Control Center 
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MCP-M Motorola Communication Processor – MODBUS 

MDLC Motorola Data Link Communication 

MODBUS MODICON BUS Protocol 

MOSCAD Motorola SCADA 

MOSCAD-L Motorola SCADA-Light 

NEMA National Electrical Manufacturers Association (issues enclosure standards) 

NTP Network Time Protocol 

OPC Open Connectivity 

OVF Overflow 

PC Personal Computer 

PLC Programmable Logic Controller 

PPC Power PC 

PPH Pulse per Hour 

PPM Particle Per Million 

PPP Point-to-Point Protocol 

PPS Pulse per Second 

PSTN Public Switched Telephone Network 

RAM Random Access Memory 

RF Radio Frequency 

ROM Read Only Memory 

RST Reset 

RTS Request to Send 

RTU Remote Terminal Unit (can be MOSCAD or MOSCAD-L) 

RX Receive 

SCADA Supervisory Control and Data Acquisition 

SBO Select Before Operate 

SDRAM Synchronous Dynamic Random Access Memory 

SNMP Simple Network Management Protocol 

SNTP Simple Network Time Protocol 

SPDT Single Pole Double Trigger 

SPST Single Pole Single Trigger 

STS System Tools Suite 

SW Software 

TB Terminal Block 
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TCP Transmission Control Protocol 

TDPSK Trunked Differential Phase Shift Keying 

TX Transmit 

UDF Underflow 

UDP User Datagram Protocol 

USB Universal Serial Bus 

WAN Wide Area Network 

WB Wire Break 
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DESCRIPTION 

Product Overview 
The ACE3600 is a programmable Remote Terminal Unit (RTU). Almost any automation task 
can be implemented with a suitable choice of ACE3600 components.  Typically the RTU 
monitors and controls local equipment and communicates with a control center and with other 
RTUs in the system.  The ACE3600 is the newest Motorola SCADA (MOSCAD) RTU, a 
member of MOSCAD family of RTUs and Control Center Front End Processors. 

The ACE3600 System Tools Suite (STS) can be run on a local or remote PC to perform all the 
setup, programming and monitoring operations such as RTU configuration, system/application, 
download, monitoring, etc.  

Features of the ACE3600 
The ACE3600 combines all the advantages of the legacy MOSCAD and MOSCAD-L RTUs 
with those of modern hardware and software technologies.  

Among these are: 

• A modern CPU platform with powerful microprocessor 

• Real-time operating system based on Wind Rivers VxWorks OS 

• Enhanced communication and networking capabilities 

• Rugged modular design 

• Extended operating temperature range 

• Improved power supply/charger  

• Modules with a high component density 

• System building tools 

• Interoperability with legacy MOSCAD family RTUs 

General Description 
The ACE3600 RTU is a modular unit, comprised of removable modules installed in a multi-
slot frame.  These modules include  

• Power supply  

• CPU 

• I/O modules   
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The basic (default) model includes one power supply and one CPU module.  The number of 
I/O modules is selected as an option of the base model. 

Figure 1-1 provides a general view of the ACE3600 RTU with five I/O modules. 

 

 

Figure 1-1 ACE3600 RTU – General View 
 

I/O Module Options 
The following types of I/O modules are available: 

• Digital Inputs (DI)  

• Relay Digital Outputs (DO) 

• Analog Inputs (AI)  

• Mixed I/O 

Communication Interfaces  
The ACE3600 CPU includes the following serial ports: 

• Configurable RS232 or RS485 serial port 

• Configurable RS232 with GPS receiver support (for time sync)   

• Ethernet 10/100 Mb/s (ACE3640 models) 

Two additional plug-in ports can be added to the CPU.  The following types of communication 
modules are available for the plug-in ports: 

POWER 
SUPPLY 
MODULE 

CPU MODULE 

MOUNTING 
PLATE 

I/O MODULES 
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• RS232  

• RS485  

• General radio interface (Conventional or Trunking, DPSK 1200, FSK 2400, DFM 4800, 
Duo-binary 9600) 

• Ethernet 10 Mb/s 

• Ethernet 10/100 Mb/s (on plug-in Port 1 only)  

ACE3600 RTU Construction 
The ACE3600 is available in various structures: 

• Frame which can accommodate a varied number and type of modules 

• Metal chassis which accommodates the frame, and optional radios, backup battery and 
communication interfaces 

• Protective housing which accommodates the frame, and optional radios, backup battery 
and communication interfaces (suitable for outdoor installation) 

The ACE3600 frame consists of the following elements: 

• Plastic slots which accommodate the power supply, CPU and I/O modules, and 
backplane bus motherboard 

• Mounting plate for attaching the plastic slots together and mounting the frame on a 
wall 

• Backplane bus motherboard which connect the modules to each other via the signal 
buses and connects the modules with operating voltages 

• Power junction box for AC or DC power source and ground connections 

A frame can be mounted on the wall or installed in a 19” rack or customer enclosure.  For more 
information, see the Installation chapter below 

The ACE3600 frame can include wide or narrow plastic slot units: 

• Wide slot unit - can hold a power supply and a CPU or up to three I/O modules 

• Narrow slot unit - can hold up to two I/O modules  
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RTU Options 
Each RTU can include a number of options, including portable and mobile radios, and plastic 
boxes with interface card for communication, etc.   

Housing/Mounting Type Capacity/Options Illustration 

No I/O slot frame 
Basic (default) model. 

Can be installed on a wall. 

Power supply and CPU 

Can be ordered with metal 
chassis or housing options. 

 
3 I/O slot frame 

Can be installed on a wall. 

Power supply and CPU, 
up to 3 I/Os 

Can be ordered with metal 
chassis or housing. 

 
5 I/O slot frame 

Can be installed on a wall. 

Power supply and CPU, 
up to 5 I/Os 

Can be ordered with large 
metal chassis or housing. 

 
7 I/O slot frame 

Can be installed on a wall. 

Power supply and CPU, 
up to 7 I/Os 

Can be ordered with large 
metal chassis or housing. 

 
8 I/O slot frame  

Can be installed on a wall or in 
19” rack/enclosure.  

Power supply and CPU, 
up to 8 I/Os 
 
Can be ordered with metal 
chassis option for accessories: 
6.5 or 10 Ah Lead-Acid 
backup battery 
up to 2 radios;  
up to four plastic boxes. 

 

Small metal chassis 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall or in 
housing.  

Power supply and CPU, 
up to 3 I/Os, 
1 mobile/portable radio, 
1 plastic interface box, 
6.5 Ah Lead-Acid backup 
battery 
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Housing/Mounting Type Capacity/Options Illustration 

Large painted metal chassis 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall or in 
housing. 

Power supply and CPU, 
up to 7 I/Os,  
1 plastic interface box,  
up to 2 mobile/portable 
radios, 
6.5 or 10 Ah Lead-Acid 
backup battery  

Small NEMA 4X/IP65 housing 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall. 

Power supply and CPU, 
up to 3 I/Os,  
1 mobile/portable radio, 
1 plastic interface box,  
6.5 Ah Lead-Acid backup 
battery 

 
Large metal NEMA 4X/IP65 
housing 

Enables installation of radio, 
backup battery and other 
accessories. 

Can be installed on a wall. 

Power supply and CPU, 
up to 7 I/Os,  
1 plastic interface box,  
up to 2 mobile/portable 
radios, 
6.5 or 10 Ah Lead-Acid 
backup battery 

 
 

For installation instructions of each housing/mounting type, see the Installation chapter. 

For the dimensions and weight of each combination, see Appendix A: General Specifications. 

For a detailed list of all ACE3600 options, see the ACE3600 price pages and ordering 
information.  

For a detailed description of the individual modules, see the appropriate chapter below. 
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RTU Components 
The ACE3600 RTU can include the following components. 

Component Function Notes 

Power supply module Converts the main AC or DC 
power source to the voltages 
required by the modules, 
radio/modems and 
accessories.  
Charges the backup battery 
and switches to the battery 
voltage when the main power 
fails (in models with charger.)

See Power Supply Module 
and Backup Battery chapter. 

CPU module Stores and runs the user 
application program, stores 
data collected by the I/O 
modules and communicates 
with the control center, RTUs 
and other devices via the 
communication ports. 

See CPU Module chapter. 

CPU plug-in port Enables adding various 
communication ports to the 
CPU modules. 

See CPU Module chapter. 

CPU plug-in SRAM Provides static RAM. See CPU Module chapter. 

I/O module Matches between the 
ACE3600 and signals of 
various types/levels.   
Interfaces between the 
ACE3600 and the process 
signals. 

See I/O Modules chapter. 

Terminal blocks (TB) Connects the signals to the 
I/O modules. 

See I/O Modules chapter. 

Plug-in 24V DC power supply Enables adding 24 V floating 
power supplies to I/O 
modules for contact “wetting” 
and sensor operation. 

See I/O Modules chapter. 

TB holder kit Holds Module TBs. See I/O Modules chapter. 

Cable with TB holder A cable to connect signals to 
the I/O modules. 

See I/O Modules chapter. 

Backup battery Enables backup RTU 
operation when main power 
fails. 

See Power Supply Module 
and Backup Battery chapter. 
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Component Function Notes 

Radio installation kit Mechanical support and 
cables that enable installation 
of radio. 

See Radio Types and 
Installation Kits chapter. 

RS485 Junction Box Enables connection of up to 5 
devices to the RS485 port on 
the CPU (2W multi-drop). 

See Connecting Power and 
Ground in the Installation 
chapter. 

RTU to PC RS232 cable Enables connection of the 
RTU to a PC via the RS232 
port. 

For use of the ACE3600 
Software Tools Suite (STS) 
to perform operations such 
as RTU configuration, 
system/application, 
download, monitoring, etc.  
See the ACE3600 STS User 
Guide. 

RTU to PC Ethernet cable Enables connection of the 
RTU to a PC via the Ethernet 
port. 

For use of the ACE3600 
Software Tools Suite (STS) 
to perform operations such 
as RTU configuration, 
system/application, 
download, monitoring, etc.  
See the ACE3600 STS User 
Guide. 

 

Model Options and Accessories 
F7500  -  ACE3600 System Tools Suite Software 

F7600  -  ACE3600 ‘C’ Toolkit Software  

The full list of ACE3600 options and accessories are listed in the ACE3600 System Planner.  

Product Safety and RF Exposure 
Before using an ACE3600 RTU model with a radio installed, read the operating instructions 
and RF exposure booklet for the specific radio contained in the product.  
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INSTALLATION 

General 
The ACE3600 RTU is shipped from the factory with the modules and plug-in ports assembled.  
The RTU frame is ready for mounting directly on a wall or in a customer's enclosure. The eight 
I/O frame can be installed on a 19” rack. 

Modules can be added to the slots in a frame before or after mounting the RTU on a 
wall/enclosure.   

 

Installation of the ACE3600 should be done only by authorized and 
qualified service personnel in accordance with the US National Electrical 
Code. Only UL Listed parts and components will be used for installation. 
Use UL Listed devices having an environmental rating equal to or better 
than the enclosure rating to close all unfilled openings.  

If the installation involves high-voltage connections, technicians must be 
specifically qualified to handle high voltage. 

If the I/O connections are powered by a hazardous voltage (>60VDC or 
>42Vpeak), all inputs should be defined as hazardous and the unit must be 
installed in a restricted access area for service personnel only. 

If the I/O connections are powered by a safety extra low voltage (SELV) 
(<60VDC or <42Vpeak), all inputs should be defined SELV.  

INSTALLATION CODES 

This device must be installed according to the latest version of the 
country's national electrical codes. For North America, equipment must be 
installed in accordance to the applicable requirements in the US National 
Electrical Code and the Canadian Electrical Code. 

INTERCONNECTION OF UNITS 

Cables for connecting RS232 and Ethernet Interfaces to the unit must be 
UL-certified type DP-1 or DP-2. (Note- when residing in a non LPS circuit.)  

OVERCURRENT PROTECTION 

A readily accessible Listed branch circuit overcurrent protective device 
rated 20 A must be incorporated in the building wiring. 
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External wiring which connects an I/O module to instruments/devices may 
not exceed 42.67m (140 feet).  

If the ACE3600 is subject to high levels of shock or vibration, you must 
take suitable measures to reduce the acceleration or amplitude. We 
recommend that you install the ACE3600 on vibration-damping materials 
(for example, rubber-metal anti-vibration mountings). 

METAL PARTS OF THE POWER SUPPLY MAY BE VERY HOT. 

After removing the power supply module, allow the metal parts to cool 
down before servicing the unit. 

Mounting the ACE3600 Frame on a Wall 

 

Before drilling holes for mounting the frame, make sure there are no 
electrical wires installed inside the wall at the holes’ location. 

Four holes are provided, one in each corner of the RTU frame, for wall mounting the RTU.  
Figure 2-1, Figure 2-2, and Figure 2-3 show the dimensions of the various frames/metal chassis 
and the distances between the holes. For convenient installation of the ACE3600 RTU on a 
wall, allow an additional 6 cm (2.4") (in W, H) and 7 cm (2.75") (in D) around the plate. 

295

33
0

  

410

44
3

 
Small Metal Chassis    Large Metal Chassis 

Figure 2-1.  Small/Large Metal Chassis Installation Dimensions and Screw Holes for 
Installation 
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Figure 2-2.  No I/O and 3 I/O Frame Installation Dimensions and Screw Holes for 

Installation 
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5 I/O Frame      7 I/O Large Frame 

 
Figure 2-3.  5 I/O and 7 I/O Frame Installation Dimensions and Screw Holes for 

Installation 
 

The following screw mount installation procedure should be used to install all ACE3600 
frames (with or without a metal chassis) on a wall, except the 8 I/O (19”) frames. 

Procedure 2-1  How to Mount the RTU Frame on a Wall 

1) Drill four holes in the wall at the horizontal and vertical distances shown in Figure 2-1 and 
Figure 2-2.  

2) Insert M4 screws (not supplied) with head size DIN 7981C/ST4, 2x38mm into the holes. 

3) Remove the modules from the frame.  

4) Lift the RTU frame and hang over the four screws. 

5) Remove the outermost modules in order to access the screws. 
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6) Tighten all four screws with a screwdriver to secure the frame firmly against the wall. 

7) Replace the removed modules in their slots. 

Installing the ACE3600 in a 19" Rack 
The following screw mount installation procedure should be used to install the ACE3600 8 I/O 
(19”) frame in a 19" rack. 

Note: The brackets for 19" rack installation are not provided with the RTU and should be 
ordered separately. 

Procedure 2-2  How to Mount the RTU in a 19" Rack Unit 

1) Press the small metal bracket into the slot of the larger bracket.  See Figure 2-4. 

2) Secure the two brackets together with two M5 screws (supplied), according to the desired 
depth of the unit on the rack.  See Figure 2-4. 

3) Repeat steps 1-2 for the other pair of brackets. 

4) Using the supplied two screws, attach the combined brackets to the metal pole of a 19" 
rack unit.  See Figure 2-4.  Repeat on other side. 

Bracket Groove

Small Bracket

Large Bracket

Metal Pole

 

Figure 2-4.  Installation of Brackets for 19" Rack Units 
 

5) Hang the 19'' metal chassis on the brackets, so that the two teeth on the back of the metal 
chassis hook onto the groove of the larger bracket.  
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Figure 2-5.  Installation of ACE3600 RTU 19" Rack- Exploded View 
 

6) From the standard rack unit, remove the two modules from the leftmost slots and the two 
modules from the rightmost slots.  For the 19” accessories metal chassis, no accessories 
need to be removed.  (See Figure 2-6.) 

7) Using two supplied M5 (X6) screws and a 16 cm (6.3") long screwdriver, from inside the 
slot secure the 19" metal chassis to the small bracket.  Repeat on the second side.  See 
Figure 2-5. 

8) Replace any removed modules to their slots. 
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Mobile Radio

Portable Radio
Plastic Boxes

Battery
 

Figure 2-6 Installation of ACE3600 RTU 19" Rack Accessories - General View 

Mounting the ACE3600 8 I/O Frame on a Wall 
453

450

12
8

93

 
Figure 2-7.  RTU Metal Chassis Installation Dimensions 

Procedure 2-3  How to Mount the RTU 19" Metal Chassis on a Wall 

The following installation procedure should be used to install the 8 I/O (19”) frame on a wall, 
using the special wall mount brackets provided with the RTU.  

1) Remove the CPU, Power Supply and I/O modules from the RTU rack. 

2) Drill four holes into the wall at the horizontal and vertical distances shown in Figure 2-7.   

3) Using two supplied screws, secure the rectangular wall mounting bracket to the wall.   
Repeat for the second bracket. 
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4) Hang the metal chassis on brackets so that the 2 teeth of the metal chassis hook onto the 
groove of the brackets.  (See Figure 2-8.) 

5) Using two M4 screws (not supplied) with head size DIN 7981C/ST4, 2x38mm screws, 
secure the top and bottom of the rack to the left bracket.  Repeat for the right bracket. 

 

 

 

 
Figure 2-8.  RTU Metal Chassis Installation  

Mounting the ACE3600 NEMA4 Housing on a Wall 
The following screw mount installation procedure should be used to install ACE3600 frames in 
NEMA4 housing on a wall.  

For convenient installation of the ACE3600 RTU with the NEMA4 housing, allow an 
additional 6 cm (2.4") (in W, H) and 7 cm (2.75") (in D) around the housing. 

Four mounting brackets are provided, one in each corner of the RTU, for wall mounting the 
RTU housing (see Figure 2-9 through Figure 2-11).  Figure 2-9 and Figure 2-10 show the 
distances between the bracket holes.   
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20.86º (53.0 cm)

20.86º

17.40º (44.2 cm)

17.40º
(53.0 cm) (44.2 cm)

 
Horizontal Bracket Installation              Vertical Bracket Installation 

Figure 2-9.  Large NEMA 4 Housing - Installation Dimensions 
 
 

16.2º (41.2 cm)

16.2º
(41.2 cm)

12.6º (32.0 cm)

12.6º
(32.0 cm)

 
Figure 2-10.  Small NEMA 4 Housing - Installation Dimensions 

 

Procedure 2-4  How to Mount the RTU NEMA4 Housing 

1) Drill four holes in the wall at the horizontal and vertical distances shown in Figure 2-9 (for 
the large housing) and in Figure 2-10 (for the small housing.) 

2) Using the brackets and the screws supplied in the plastic bag, fasten the mounting brackets, 
either horizontally or vertically, onto the four back corners of the housing.  See Figure 2-
11. 

3) Mount the RTU onto the wall and secure with M4 screws (not supplied) with head size 
DIN 7981C/ST4, 2x38mm through the bracket hole.  See Figure 2-11. 
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MOUNTING
BRACKET

PRE±INSTALLED
(WELDED) ON SOME
HOUSING BRANDS

 
Figure 2-11.  Mounting the NEMA 4 Housing 

 

Connecting Power and Ground 
All internal electrical connections except for the main power, ground and battery are performed 
in the factory and supplied with the RTU.  The electrical interconnection diagrams are 
provided in the Break-Fix Procedures chapter. 

The procedures for the main power, ground and battery connections are provided below. 

 

The power and ground connections should be performed only by qualified 
and authorized service personnel.  All power and ground connections 
must be in accordance with local standards and laws.  

Per UL 60950 / EN 60950, install an external circuit breaker rated at 6 A 
between the power source and the ACE3600 Power supply. 

Per UL 60950 / EN 60950, for all I/O modules connections, the maximum 
voltage should not exceed 60V DC or 30 V AC unless it is specifically 
written otherwise. 

To maintain Overvoltage (Installation) Category II, install a suitable surge 
suppressor device in the branch circuit to limit expected transients to over 
voltage Category II values. The limits are based on IEC60664 and are also 
located in Table 2H of UL60950 (for mains = 150V, the transient rating is 
1500V; for 150V < mains = 300V, the transient rating is 2500V; and for 300V 
< mains = 600V, the transient rating is 4000V). 
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Make sure that the ground wire on the user cable is long enough to reach the 
grounding strip. 

Connecting AC/DC Main Power 
The power connection to all the ACE3600 power supply types is via the power junction box 
located on the frame beneath the power supply slot.   

 

Safety standards require that the power cable be attached to the unit at two anchor 
points:  

• Anchor point 1 for all units is inside the power junction box.  (See Figure 2-12 
below.) 

• Anchor point 2 for the basic model (No I/O Slots Frame) is located on the right of 
the power junction box. (See Figure 2-12 below.) 
Anchor point 2 for all units with housing (other than No I/O Slots) is in the 
housing power cable gland. (See Figure 2-16 below.) 
Anchor point 2 for all other units without housing (other than No I/O Slots) is 
near the unit’s ground strip. (See Figure 2-13 below.) 

Clamp - Anchor Point 
Clamp - Anchor Point 

 
Figure 2-12.  RTU on No I/O Frame – Cable Anchor Points 1 and 2 
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Anchor Point 2 Clamp  
Figure 2-13.  RTU on Metal Chassis – Cable Anchor Point 2 

 

Procedure 2-5  How to Connect the RTU to Main Power Source (Units with Frames and Metal 
Chassis) 

1) Using a screwdriver, open the power junction box cover (save the screws) and unscrew the 
power terminals screws inside the power junction box. 

2) Thread the user's main power cable through the two supplied clamps. 

3) Attach the wires of the user cable, according to the labels (~/0 for AC and +/- for DC.) For 
the No I/O Frame, connect the ground cable to the lower wire terminals (third pair). Figure 
2-14 and Figure 2-15. 

Power Supply
Cable Inlet

User Power Cable

Wire 
Terminals

Anchor Point 1

Junction BoxGround Cables

Cable to Power Supply

0   ~

0   
~

 

Figure 2-14.  RTU Power and Ground Connections - No I/O Frame Installation 
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Power Supply
Cable Inlet

User Power Cable

Wire 
Terminals

Anchor Point 1

Junction BoxGround Cables

Cable to Power Supply

0   ~

0   
~

 

Figure 2-15.  RTU Power and Ground Connections – All Other Installations 
 

4) Pass the power cable to the right of the wire terminals inside the junction box, over the 
horizontal ridge.  

5) Close the first clamp around the user cable and screw it onto the junction box, into the hole 
next to wire terminals (anchor point #1).  

6) Close the second clamp and screw it onto the anchor point near the grounding strip (or on 
the bottom of the plastic to the right of the junction box in case of the No I/O Slots frame.) 

7) Replace the junction box cover over the junction box.  

8) Secure the junction box cover with two saved screws. 

9) For all installations except the No I/O frame, loosen the two screws on the grounding strip 
at the bottom of the metal chassis/housing and connect the ground cable to the protective 
ground. Tighten the screws firmly.  

10) Open the door of the power supply module and press in the cable holder downwards.  

 
11) Plug the connector of the power supply cable (3089004V64 for DC, 3089004V65 for AC) 

into the cable inlet on the power supply module (on the bottom of the front panel.) and 
rotate the cable holder upwards to secure. 
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Procedure 2-6  How to Connect the RTU to Main Power Source (Units with Housing) 

1) Using a screwdriver, open the power junction box cover (save the screws) and unscrew the 
power terminals screws inside the power junction box. 

2) Insert the rubber grommet (supplied) into the threaded plastic cable gland, and place it into 
the hole on the bottom of the housing (from the outside.)  (See Figure 2-16.) 

3) Place the nut into the same hole from inside the housing and screw the nut onto the cable 
gland. (See Figure 2-16.) 

4) Thread the user's main power cable (110/220VAC or 24-48VDC) through the cable gland 
cover from below, through the cable gland, and into the housing. (See Figure 2-16.) 

Cable 
Gland 

Grommet 

RTU Housing

NutCable 
Gland  
Cover

Power 
Cable 

 
Figure 2-16.  RTU in NEMA4 Housing – Cable Gland Anchor Point 2 

 
5) Attach the wires of the user cable, according to labels (~/0 for AC and +/- for DC.) See 

Figure 2-14 and Figure 2-15. For the No I/O frame, connect the ground cable to the lower 
wire terminals (third pair). 

6) Tighten the screws of the wire terminals and screw the wire terminals onto the junction 
box. 

7) Pass the power cable into the right side of the junction box, over the horizontal ridge. 

8) Place the user cable into the clamp, close the clamp and screw it onto the junction box, into 
the hole next to wire terminals (anchor point #1). 

9) Replace the junction box cover over the junction box. 
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10) Secure the junction box cover with the two saved screws. 

11) For all installations except the No I/O frame, loosen two screws on the grounding strip at 
the bottom of the metal chassis/housing and connect the ground cable to the protective 
ground. Tighten the screws firmly. 

12) Screw the top of the cable gland tightly to the cable gland to secure the cable (anchor point 
#2). 

13) Open the door of the power supply module and release the cable holder (press downward). 

14) Plug the connector of the power supply cable (3089004V64 for DC, 3089004V65 for AC) 
into the cable inlet on the power supply module (on the bottom of the front panel.) and 
close the cable holder. 

Connecting the Backup Battery 
The backup battery of ACE3600 is shipped from factory disconnected. Use this procedure to 
connect the battery cable to the power supply charger. 

 

Before using the Lead Acid backup battery, it is strongly recommended to read the 
information on the battery provided in the Power Supply Module and Backup Battery 
chapter. 

Lead acid batteries will self-discharge if they are stored without charging. Self-
discharge below the manufacturer's recommended voltage will result in internal 
permanent damage to the battery rendering it inoperable. When this occurs, if 
connected to a power supply/charger, the battery may produce excessive internal heat 
and therefore deform and/or leak. 

 

A battery contains diluted sulfuric acid, a toxic and corrosive substance.  
Avoid any bodily contact with the leaking liquid when handling leaking 
batteries and affected parts.  If the battery leaks and the liquid inside touch 
the skin or clothing, immediately wash it off with plenty of clean water.  If 
the liquid splashes into eyes, immediately flush the eyes with plenty of 
clean water and consult a doctor.  Sulfuric acid in the eyes may cause loss 
of eyesight and acid on the skin will cause burns. 

Procedure 2-7  How to Connect the Backup Battery 

1) Check the battery visually. If the battery looks deformed and / or you notice corrosion on 
the battery terminals and / or the battery leaks, DO NOT use the battery and replace it with 
a new battery. 
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2) Check the battery terminal voltage level before connecting it. If the battery voltage is less 
than 10V DC, DO NOT use the battery and replace it with a charged battery that measures 
at least 10V DC. 

3) If the battery passes a visual inspection and the terminal voltage is correct, plug the battery 
cable (3089927V10) into the Battery In/Out connector on the power supply module. 

4) Fully charge the battery prior to initial use (~10 hours). 

Connecting the Radio 
A radio which is shipped in the ACE3600 is fully connected.  To add a radio to the ACE3600, 
use the appropriate radio installation kit.  For information on radio types, radio installation kits 
and connections, see the Radio Types and Installation Kits chapter. 
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POWER SUPPLY MODULE AND BACKUP BATTERY 

General Description/Module Overview 
The ACE3600 power supply module provides the other modules in the RTU with their 
operating voltages via the motherboard bus. 

The following power supply options are available: 

• DC power supply (10.5-16V) - provided by default with the ACE3600 RTU 

• DC power supply (18-72V) 

• DC power supply (18-72V) with battery charger 

• AC power supply- 85-264V 

• AC power supply- 85-264V with battery charger 

 

Common characteristics of all power supply modules: 

• On/Off switch on the front panel 

• Controlled auxiliary voltage outputs 

• Heat convection cooling (no need for fans) 

• Short protection outputs 

• Over heating protection 

• The module function is monitored by the CPU module. 

• Status LEDs in the front panel 

• PS located on the leftmost slot of the frame 

• Input current protection fuse 

• Controlled power line enables centralized disabling of Electrically Energized relay outputs 
in selectable DO modules. 

Common characteristics of power supply modules with battery charger: 

• Automatic switchover to battery on power fail 

• Automatic switchover to main power on power return 

• Temperature compensated charging 

• Over-charging protection 
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• Over-discharge protection 

• Battery test and diagnostics, including battery controlled discharge 

Figure 3-1 below depicts a general view of the power supply.  

 DO 
BATT

AUX1

PWR

AUX2

AC-DC/DC-DC 
Converter 
(in AC or 
18-72V DC PS 
only)

AUX 1A

AUX 1B

AUX 2A

AUX 2B

12V_DO

Battery

Rack Exp

Temp

Power In 

18-72 

VDC

AUX 1A

ON

OFF

 

Figure 3-1 ACE3600 Power Supply – General View 
 

 

METAL PARTS OF THE POWER SUPPLY MAY BE VERY HOT. 
After removing the power supply module, allow the metal parts to cool 
down before servicing the unit. 
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Figure 3-2 below depicts a detailed view of the power supply front panel.  

PWR

AUX1

AUX2

 DO

Auxiliary Output 1A
Auxiliary Output 1B
Auxiliary Output 2A
Auxiliary Output 2B
12V DO Control
12V Out (Reserved)
Battery In/Out
Temperature Sensor

AC/DC Main Power Input

BATT

On/Off Switch

Indication LEDs

 

Figure 3-2 ACE3600 Power Supply – Front Panel 
 

ON/OFF Switch 
The front panel of the power supply module includes an ON/OFF switch for the module.  In the 
OFF (down) position, all the power outputs except Battery In/Out are disabled.  A mechanism 
is provided to prevent accidentally changing the switch position. 

 

In power supply modules equipped with a battery charger, if the ON/OFF switch is in 
the OFF position, and the RTU main power is connected, the Battery In/Out is not 
disabled to ensure battery charging. 
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Input/Output Connectors 
The front panel of the power supply module includes the following connectors.   

Connector Name Description Notes 
Auxiliary Output 1A 13.2V DC (±20%) 

User controlled power 
output.  
Short protected. 

This output is used for 
powering radios, modems, 
etc.  
The output can be switched 
ON/OFF either by user 
application program or by a 
using the STS hardware test.  
(Default = ON) 
For more information, see the 
Performing Hardware Tests 
section or Application 
Programmer section of 
ACE3600 STS User Guide. 

Auxiliary Output 1B Same as Auxiliary Output 1A Same as Auxiliary Output 1A

Auxiliary Output 2A DC Power Output  
Selectable/programmable  
3.3 to 9V DC or  
13.2V DC±20%.  
User controlled power 
output.  
Short protected. 

This output is used for 
powering radios, modems, 
etc.  
The output can be set by the 
user with the STS 
configuration function.   
The output can be switched 
ON/OFF either by a 
hardware test or by user 
application program. (Default 
= OFF) 
If both 2A and 2B are ON, 
they must have the same 
output level.  The voltage 
levels of AUX2A and 
AUX2B are the same. 

Auxiliary Output 2B Same as Auxiliary Output 2A Note: Auxiliary Output 2B 
can be ON independently of 
2A.   
If both 2A and 2B are ON, 
they must have the same 
output level.  
The voltage levels of 
AUX2A and AUX2B are the 
same. 
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Connector Name Description Notes 
12V DO Control Control input that enables 

centralized disabling of 
Electrically Energized (EE)/ 
Magnetically Latched (ML) 
relay outputs in selectable 
DO modules. 

Input open = Relays are 
disabled. 
Input shorted = Relays are 
enabled. 

This input controls a 
dedicated 12V power line 
that is available to all the 
slots in the frame.  In each 
relay DO module, the user 
can mechanically select to 
power the relay coils from 
this dedicated 12V power 
line.  

For details on setting this 
control, see the Module 
Configuration section of the 
DO Relay Module chapter. 

12V Out  (Reserved) Pin 1- PGND 
Pin 2- 12V DO 
Pin 3- GND 
Pin 4- MAIN (12V) 

Battery In/Out  
(only in power supply with 
charger) 

Battery charger output when 
the main power exists. 

Backup power input from 
battery when the main power 
fails. 

The charging voltage level is 
controlled by the battery 
charger and is a function of 
the temperature. 

Temperature Sensor Sensor for battery 
temperature to control 
charging level.   

(In modules with power 
supply and charger only)  
For more information, see the 
Backup Battery section 
below. 

AC/DC Main Power Input Cable inlet for main power 
cable (AC or DC) 

The cable is part of the RTU 
frame (connected to the 
power junction box. 

Note: When the cable male 
connected is place in this 
input, it locks the power 
supply module in its slot.  To 
remove the power supply 
module, first unplug the 
power input cable. 
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LEDs 
The front panel of the power supply module includes five indication LEDs. 

LED Name Description Status 

PWR Power LED  Indicates the existence of AC or DC main 
power in the Main Power input. 

When the ON/OFF switch is in ON position - 
the LED is lit in Green. 

When the ON/OFF switch is in OFF position, 
but there is AC or DC input - the LED is lit in 
Red. 

When there is no AC or DC input - the LED is 
OFF. 

AUX1 Auxiliary Output 1 LED AUX1A is ON - Green 
AUX1B is ON - Red  
AUX1A and AUX1B are ON – Orange 

AUX2 Auxiliary Output 2 LED AUX2A is ON - Green 
AUX2B is ON - Red  
AUX2A and AUX2B are ON – Orange 

DO Digital Output Control LED Relays enabled – LED ON – Green 
Relays disabled – LED OFF 

BATT Battery LED No battery/thermistor - LED OFF  

Battery is fully charged (charging current 
<20mA) - LED ON - Green  

Battery is being charged (charging current  
>20mA and <600mA)- LED ON – 
Green/Yellow Blinking 

Battery is being charged (charging current 
>600mA)- LED ON – Yellow  

Battery is discharging (battery voltage is 
higher than voltage of power supply) - LED 
ON – Red. 

Battery charging current is stabilizing - LED 
ON – Yellow Blinking. 

Battery tests are performed using the STS 
Hardware Test function or the user 
application program. 
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Battery Charger 
Power supply modules with a battery option support a 6.5 or 10 Ah Lead-Acid battery.  The 
power supply automatically switches to the backup battery as a 12V DC power source for the 
RTU and communications when the main AC or DC power source fails. 

Power supply modules with a 12 VDC smart battery charger option charge the backup battery 
when not in use, and protect the battery from over-discharge.  The charger performs battery 
tests/diagnostics, including controlled battery discharge, when requested by the user.  If the 
battery is failed, the charger will not charge it and will send a failed status signal to the CPU.  
If the battery is remotely located, long battery cables can be used.   

Charging the Battery 
The charging voltage of the Lead-Acid battery is controlled by the charger as a function of the 
battery temperature. The charging profile is set to comply with the temperature-compensated 
float-voltage of the ACE3600 battery. 

Diagnostics 
A battery test can be performed on the Lead-Acid battery, either from the ACE3600 STS 
Hardware Test utility or from the user application program.  The battery test includes disabling 
the battery charger, discharging the battery and measuring the capacitance.  For more 
information, see the Hardware Test section or the Creating a User Application section of the 
ACE3600 STS User Guide.  

 

It is recommended to run a battery capacity test once per month (for more exact results 
perform at 10˚ to-30˚C), and a charge level test once per day.  The capacity test 
discharges the battery for 20 seconds and then measures the output.  If the capacity is 
below the manufacturer recommended level, the battery should be replaced with a new 
one.  (See Replacing the Backup Battery below.)  Note that the capacity test is only 
available for the battery types supplied by Motorola. 

The results of the battery capacity test can be:  

• Battery OK 

• Battery needs to be replaced 

• Test blocked - bad environment 

The battery capacity test will be blocked under the following conditions: 

1.  If the battery is discharging (battery is main power source of RTU), 

2.  If the battery or thermistor is disconnected, 
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3.  If the battery temperature is outside the specified range (-30˚ to 60˚C),  

4.  If the battery is not fully loaded. 

Connecting the Power Supply to a Power Source 
The power supply can be connected to an AC or DC power source.   

For instructions on connecting the power supply to a power source, see the Power and Ground 
Connections section of the Installation chapter above. 

 

All power and ground connections must be in accordance with local standards and 
laws. 
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Power Supply Detailed Specifications 
Input voltage DC 10.5-16 V  (Default) 

DC18-72 V DC  (option V251) 

18-72 V DC with 12V smart battery charger  (option V367) 

85-264 V AC , 50/60 Hz  (option V346) 

85-264 V AC, 50/60 Hz  with 12V smart battery charger   (option V261)  

Total Power Maximum 60 W continuous; maximum 105 W peak @ 25% duty cycle 

Outputs To motherboard (for CPU and I/O modules): 13.2 V DC ±20%, max. 8A 

AUX1A/AUX1B user connectors: 13.2V D ±20% C, max.8A  

AUX2A/AUX2B: 13.2 V DC ±20%, max. 8A or 3.3 / 5 / 7.5 / 9 V DC 
±10%, max. 2.5A 

Battery Charger  12 V Lead Acid battery charger (in PS with charger) 

Automatic charging of 6.5 or 10 Ah backup battery, battery temperature 
sensing, overcharging protection, battery capacity test and diagnostics, 
automatic battery switch-over. 

Diagnostics LEDs Status LED for: input voltage, AUX1 and AUX2 outputs voltages and 
battery  

Efficiency  DC: 80% typical, 76% typical (full load) 

AC: 80% typical @230 V AC, 76% typical @115 V AC (full load) 

Inrush Current  DC: 10 A maximum, for 2 mSec. Max, cold start at 25°C 

AC: 25 A maximum, for 2 mSec. Max, cold start at 25°C 

Power Factor AC: 0.98 typical at 230 V AC, 0.99 typical at 115 V AC 

Input Protection Internal Line Fuse, replaceable  

Protection Overload and Short Circuit, automatic recovery  

Over-Voltage Protection Automatic outputs shut down 

Insulation DC: Input to case: 500 V DC, input to output 500 V DC 

AC: Input to case: 1500 V AC, input to output: 3000 V AC 

Dimensions 56 mm W x 225 mm H  x 180 mm D (2.2“ W x 8.7“ H x  7.1“ D)  
Weight DC 10.5-16 V: Approx. 0.43Kg  (0.95 Lb),  

All others       : Approx. 1kg (2.2 lb) 
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Backup Battery 

Overview 
The ACE3600 backup 12V Lead-Acid battery provides backup for the main input power.  The 
battery is available in two capacities: 6.5 Ah and 10 Ah.  Switching from main input power to 
the battery and charging of the battery is performed by the ACE3600 power supply module.   

Sealed Lead Acid technology batteries can be recharged and discharged at a temperature range 
of -40º to +70ºC. Storage and operating temperatures affect the battery capacity and lifespan. 
ACE3600 power supply modules include a special charging power supply designed to fit the 
specific temperature-compensated float-voltage-charging curve of the battery.  

 

Lead Acid batteries will self-discharge if they are stored without charging. Self-
discharge below the manufacturer's recommended voltage will result in internal 
permanent damage to the battery rendering it inoperable. When this occurs, if 
connected to a power supply/charger, the battery may produce excessive internal heat 
and therefore deform and / or leak. 

The batteries are shipped disconnected from the power supply/charger. To ensure that 
there are no battery problems on your ACE3600 project, each Lead Acid battery 
MUST be fully charged and checked before connecting it to the ACE3600 power 
supply/charger. To verify that the battery is fit for use, measure the BATTERY OPEN 
CIRCUIT voltage (when the battery is not connected to the power supply/charger) 
with a digital voltmeter.  If the battery voltage is less than 12.5 V DC, DO NOT use 
the battery and replace it with a new ACE3600 battery that measures more than 12.5 V 
DC.  

Before transporting the battery, read and follow all safety information located on the 
battery case. 

 

ACE3600 batteries are shipped from the factory tested, fully charged and with a label 
stating the next time it should be recharged when stored at temperatures of 30ºC or 
less. 

Motorola battery warranty is valid only when the battery is charged with the original 
Motorola ACE3600 charging power supplies. Use of any other power supply/charger 
will void the battery warranty. 
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Under various state or local laws, the batteries must be recycled or disposed of 
properly and cannot be disposed of in landfills or incinerators. Environmental 
protection regulations classify used Lead Acid batteries as hazardous waste, unless 
certain exemptions apply. Consideration should be given to the methods of collecting, 
labeling, handling and shipping used Lead Acid batteries. Please consult the 
environmental protection authority for specific legal requirements and for recycling 
options in your country/area. 

Backup Battery Storage, Lifespan, Inspection and Replacement 
The manufacturer’s recommendations for handling during each of the battery’s life stages are: 

• Transportation: 

Batteries must be handled with care to prevent falls, impact, short circuit or exposure 
to high temperatures and fire.  

• Battery Storage: 

Storage of batteries in a warehouse requires a periodic recharge. The time between 
these recharge cycles depends upon the storage temperature. The minimum open 
circuit voltage allowed on the battery before recharging is 12.42 V, which represents 
remaining capacity of approximately 30%. Therefore it is recommended to perform a 
full charging cycle every few months depending upon the storage temperature of the 
battery. Please refer to Table 3-1 to determine the suggested maximal period between 
recharge cycles that suits the actual storage conditions. Improper storage may cause 
deep discharge of the battery, which might cause degradation of the battery operating 
life and lower the actual delivered capacity. Motorola performs a periodic full charge 
cycle procedure on stored batteries and a final full charge operation prior to shipment. 

• Lifespan: 

The average temperature of the battery environment affects the lifespan of batteries 
installed in the field. Please refer to the battery vendor information at the following 
website: 

·  (Sonnenschein  A512/6.5S and A512/10S): http://www.sonnenschein.org/A500.htm  

• Inspection and Replacement: 

It is important to inspect the batteries periodically (recommended every 6-12 month) 
and replace any battery that has corrosion on the leads or it is deformed or leaks. Such 
a battery should be disposed according to the local environmental laws. To assure the 
battery availability and proper operation, the battery should be replaced at the end of 
its lifespan (approximately 30% capacity) even if it is still functional. Measure the 
battery open circuit voltage using a digital voltmeter as described above. Please note 
that using a battery beyond its lifespan period may cause a battery heating, leakage 
and/or deformation.  
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Table 3-1: Recommended Time between Periodic Battery Recharge vs. Storage Temperature 
Average Storage 

Temp (°C) 
Recharge Interval 

(Months) 

25 12 

45 4 

60 1 
 

Replacing the Backup Battery 

 

A battery contains diluted sulfuric acid, a toxic and corrosive substance. Avoid any 
bodily contact with the leaking liquid when handling leaking batteries and affected 
parts. If the battery leaks and the liquid inside touch the skin or clothing, immediately 
wash it off with plenty of clean water. If the liquid splashes into eyes, immediately 
flush the eyes with plenty of clean water and consult a doctor. Sulfuric acid in the eyes 
may cause loss of eyesight and acid on the skin will cause burns. 

Procedure 3-1 How to Replace the Lead Acid Backup Battery 

To replace the Lead-Acid backup battery, follow the procedure below. 

1) Disconnect the battery cable from the Battery connector of the power supply (see 
Figure 3-2) and from the battery. 

2) Unscrew the battery holders (two screws in the small battery and four screws in the 
large battery) with the attached battery temperature sensor.  (See Figure 3-3 below.) 

               

Figure 3-3 Backup Batteries – Exploded View 
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3) Remove the old battery from the RTU. 

4) Check the replacement battery visually.  If the battery looks deformed, if you notice 
corrosion on the battery terminals, or the battery leaks, DO NOT use the replacement 
battery; get another replacement battery.   

5) Check the replacement battery terminal voltage level before connecting it. If the 
battery voltage is less than 10V DC, DO NOT use the battery and replace it. 

6) If the replacement battery passed the visual inspection and the terminal voltage is 
satisfactory, put the battery into place on the RTU and screw in the battery holders. 

7) Connect the battery cable to the battery terminals in the correct polarity. 

8) Connect the battery cable to the Battery In/Out connector on the front panel of the 
power supply module. 

9) Recharge the replacement battery for 10 hours to be fully charged. 
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CPU MODULE 

General Description 
The main element of the ACE3600 is the CPU module. It controls the I/O modules, processes 
the gathered data and communicates with the outside world. 

The core of the module is Freescale’s MPC8270 32-bit microprocessor which has extended 
communication capabilities, high speed core, DMA and floating point calculation support.  The 
module includes on-board memory, communication ports, I/O bus interface and other circuits.  
The firmware is based on Wind River’s VxWorks operating system. 

Module Location: The CPU is a removable module located in a dedicated slot in the RTU rack. 
The CPU module must be plugged into the wide slot to the right of the Power Supply module.  
(Inserting the module in the wrong slot will not cause any damage to the CPU.) 

Figure 4-1 provides a general view of the ACE3600 CPU (Models 3610 and 3640). 

PWR

ERR

RST

APPL

CONF

Tx

Rx

CM

P1

Tx

Rx

CM

S1

Tx

CM

S2

Rx

Tx

CM

P2

Rx

USR1

USR2

USR3

USR4

                    

Model 3610     Model 3640 
                       Figure 4-1  ACE3600 CPU – General View 
 

 

The CPU panel includes status LEDs, user LEDs, communication port LEDs, two pushbuttons, 
and communication ports.  The panel is covered by the module door. 
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Figure 4-2 provides a detailed view of the CPU front panel. 
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Figure 4-2  ACE3600 CPU (Model 3610/3640) – Front Panel 

Front Panel 

Communication Ports 
The CPU module includes several communication ports: 

On Board ports: 

• Serial 1  (SI1) – RS232/RS485 serial port (configurable)  

• Serial 2  (SI2) – RS232 serial port 

• Eth1  (E1) - 10/100BaseT Ethernet port (CPU 3640 only) 

Plug-in ports bays, where different types of ports can be installed: 

• Plug-in 1  (PI1) – fits RS232, RS485, 10 MB Ethernet, 10/100 MB Ethernet, or Radio 
Modem Plug-in option 

• Plug-in 2 (PI2) – fits RS232, RS485, 10 MB Ethernet, or Radio Modem Plug-in port 
option. 

For the detailed specifications of each port, see CPU Module Specifications below.  For 
information on the cables and connectors, see Appendix C. 
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Buzzer 
The CPU module includes a buzzer (audio indication), which is used to indicate task 
completion (such as end of download/upload, restart etc.) and can also be controlled from the 
user application program.   

Pushbuttons 
The CPU includes two pushbuttons on the front panel, PB1 and PB2.   

These pushbuttons are used for activating and testing the modules LED, restarting the unit, 
erasing the user Flash memory and activating memory test.  Table 4-2 describes the 
pushbuttons functionality. 

The pushbuttons can also be monitored by the user application program (when it is running) for 
the application purposes. 

LEDs 
The CPU includes CPU status LEDs, port status LEDs, and user LEDs.  Some of the LEDs are 
single color (green) and some are bicolor LEDs (red, green or orange).  

Status LEDS indicate the CPU status in startup (boot), run-time or when there is a failure. The 
communication LEDs are used to indicate the communication port status. The user LEDs can 
be used by the user application program. Note that during startup or failure, the communication 
and user LEDs are used to indicate various situations. Table 4-3 details the LEDs functionality. 

CPU Memory  
The ACE3600 CPU includes FLASH, SDRAM, and optional SRAM Plug-in memory.     

The FLASH stores the firmware, the user application program, and the user data.   

The SDRAM memory stores the temporary data. 

The optional SRAM memory expansion is used for logging user data.  The SRAM data is 
retained using an on-board rechargeable lithium battery.  The battery will retain the SRAM 
data for a minimum of accumulated 90 days without power.  When the SRAM option is not 
used, the Lithium battery will keep the Real Time Clock running for two years. 

The size of the CPU memory is determined by the model as shown in the table below. 
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Table 4-1 ACE3600 CPU Memory 
 

 Model 
3610 

Model 
3640 

Flash memory 16 Mb 16 Mb 

SDRAM 
memory:  

32 Mb 32 Mb 

User FLASH:  3 Mb 3 Mb  

User SDRAM:  10 Mb 10 Mb  

SRAM Plug-In 4 Mb 4 Mb 

Real Time Clock (RTC)  
The CPU includes a low drift RTC.  The date and time are retained using an on-board 
rechargeable lithium battery.   

The CPU date and time can be set using the ACE3600 STS.  The CPU can also be 
synchronized with other RTUs in the system, using the system clock.  For more information, 
see the Setting/Getting a Site’s Date and Time section or the Creating a User Application 
section of the ACE3600 STS User Guide. 

Backup Battery for SRAM and RTC 
The CPU module includes a rechargeable lithium battery that provides backup power and data 
retention for the SRAM and RTC.  

The lithium battery is located on the CPU board and cannot be replaced. 

The lithium battery is capable of preserving the data stored in the SRAM and RTC for 90 days 
(accumulated time of power off.)  

CPU Firmware and Operation Modes 
The CPU firmware is a real-time multitasking operating system, based on the Wind River 
VxWorks OS.  The CPU shipped from the factory with the most recent firmware version, and it 
can be updated/replaced using a remote or local connection.  Downloading firmware updates is 
performed using the STS.  (See Downloading to a Site in the ACE3600 STS manual.)  If the 
new firmware download stops or fails, the CPU will restart with the existing firmware. 



CPU Module 

4-5 

Power-up and Restart 
The CPU requires DC voltage provided by the power supply module via the motherboard 
(when the PS switch is ON).  The CPU will power-up and restart in the range of 10.5 to 16 V 
DC.  During power-up, the processor performs fast memory tests, initiates the RTU and starts 
the user program (if it was downloaded).  The end of power-up sequence is indicated by the 
buzzer.  The length of time from the beginning of CPU power-up until the user program starts 
running is approximately 5-6 seconds.  

It is possible to perform a comprehensive memory test during power-up by pressing push-
button PB1 for few seconds while switching the power supply from OFF to ON. In this case 
the power-up period is about 30-35 seconds long. 

Power-down 
When the voltage provided to the CPU module drops below 9.6VDC, the CPU will shut down 
in an orderly fashion. 

CPU Status and Diagnostics 
The CPU status is indicated on the front panel LED.  Detailed CPU status and diagnostics 
information can be retrieved from the module using the CPU Hardware Test utility.  For more 
details, see the Hardware Test section of the ACE3600 STS User Guide. 

CPU Warnings and Errors 
CPU warnings and errors are logged in the CPU memory to indicate issues or errors during 
power-up, restart, user application program execution and other modes of CPU operation.  The 
existence of CPU warnings and errors are indicated in the ERR LED on the front panel of the 
module.  Green indicates a warning, orange indicates an error and red indicates a critical error.     

The CPU error logger information can be retrieved using the STS Error Logger utility.  For 
more details, see the Error Logger section of the ACE3600 STS User Guide. 

CPU Serial Number 
Each CPU has a unique serial number. This number is printed on a label on the side of the CPU 
module front panel.  The serial number can be read using the STS Hardware Test and is also 
available to the user application program.  For more information, see the Hardware Test section 
or the Creating a User Application section of the ACE3600 STS User Guide. 

Connecting Plug-In Ports to the CPU Module 
In general, the plug-in ports are ordered as options with the RTU and are installed in the 
factory.  However, it is also possible to add plug-in ports to the CPU after it is shipped from the 
factory.  Several plug-in ports are available.  See  Communication Ports above.  
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Figure 4-3 depicts a plug-in port board attached to the ACE3600 CPU module. 

Supporting 
Pins

Plug-in 1 

Plug-in 2 

Supporting 
Pins

 

                             Figure 4-3  Plug-In Port in CPU Module 
Procedure 4-1 describes how to connect a plug-in port to the CPU. 

Procedure 4-1 How to Connect a Plug-in Port to the CPU  

1) Remove the CPU module from the RTU. 

2) Remove the cover from the desired opening on the front panel.  

3) Connect two supporting pins with screws to the plug-in port. 

4) Place the plug-in board with the RJ-45 connector facing the panel.  Carefully insert the 
plug-in board connector into the appropriate connector on the CPU board. 
For Ethernet 10/100 MB, use the J14 connector on the CPU (Plug-in 1 only.) 
For all other plug-in ports, use the J5 (Plug-in 1) or J6 (plug-in 2) connector. 

5) Connect the two supporting pins with screws to the other side of the CPU board. 

6) Replace the CPU module in the slot. 



CPU Module 

4-7 

Connecting SRAM Expansion Memory to the CPU Module 
*Future option* 

In general the plug-in SRAM is ordered as an option with the RTU and is installed in the 
factory. However, it is also possible to add plug-in SRAM to the CPU after it is shipped from 
the factory.  

Figure 4-4 depicts the user SRAM Plug-in memory in the ACE3600 CPU module. 

 

                                Figure 4-4  SRAM Expansion in CPU Module 
 

Procedure 4-3 describes how to connect a plug-in SRAM memory card to the CPU. 

Procedure 4-2 How to Connect a Plug-in SRAM Memory Card to the CPU 

1) Remove the CPU module from the RTU. 

2) Remove the cover from the connector marked P12 on the CPU board.  

3) Place the plug-in SRAM memory card with the connector facing the panel.  Carefully 
insert the plug-in board connector into the connector on the CPU board. 

4) Secure the memory card to the CPU board with the supplied screw. 

5) Replace the CPU module in the slot. 
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Pushbutton Functionality  
The table below describes the use of the two pushbuttons in various scenarios, during power-up 
and run-time. 

Table 4-2 ACE3600 Pushbutton Functionality 
 

Scenario Trigger Action  

LEDs Test During run-time, press PB1 
for five consecutive seconds.  

All the LEDS on the CPU and I/O 
modules will be lit for up to 20 
seconds and then returned to their 
previous states. 

RTU Restart During run-time, press PB1 
for 30 consecutive seconds. 

All the LEDs will be lit. Then all the 
LEDs will blink once. 

The buzzer will buzz several short 
beeps.  (If PB1 is released during this 
time the restart will not be 
performed.) 

At the long beep, release PB1 and the 
RTU will restart (and the buzzer will 
buzz.) 

Turn LEDs ON During run-time, press PB1 
more than five consecutive 
seconds.   

All the LEDS on the CPU and I/O 
modules will be lit for up to 20 
seconds. (The LEDs lit time can be 
configured in the RTU configuration 
using the STS.) 
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Scenario Trigger Action  

RAM Test During startup, press PB1.  

 

    

Ethernet LEDs
in ACE 3660+

 

A detailed memory test of SDRAM 
and SRAM plug-in is performed. 

- At the beginning of the RAM test, 
the four Ethernet LEDs (see left) will 
blink three times.  During the RAM 
test, the LEDs will be lit. 

If the RAM test succeeds, the four 
LEDs will blink three times and turn 
off and the restart sequence will 
continue.  

If the RAM test fails, the RTU will 
freeze (restart sequence stops) and the 
four LEDs will blink seven times.  
The fail error code will be displayed 
on the LEDs, in binary code, as 
follows: 

ERR Code 1

ERR Code 2

ERR Code 3

 
 
(where OFF LED = '0';  continuously 
lit LED = '1'.  The highest LED is the 
most significant.) 

   -ERR Code 1 = Error in Flash 

   -ERR Code 2 = Error in SDRAM 

   -ERR Code 3 = Error in SRAM 

- To exit/abort the RAM test in the 
middle, restart the RTU (see RTU 
Restart above.) 

Erase User FLASH During startup, press both 
PB1 and PB2 simultaneously 
until the buzzer buzzes five 
times quickly, then 
continuously for three 
seconds.  

All the user FLASH memory content 
excluding logging files (files tagged 
as data logging files) is erased, 
including the site configuration, user 
application programs, user tables, etc. 
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CPU LEDs Behavior 
The table below describes the behavior of the LEDs on the CPU module.  

Table 4-3 ACE3600 CPU LEDs Behavior 
 

LED Name Description Status 

PWR Power LED  

Bicolor LED (Red, Green) 

Flashing Red – Power exists; power-up in 
progress. 

Green – Power exists; power-up completed. 

Red – Failure on power-up. (AC fail, Bat 
Error, etc.) 

Orange - Battery test in progress. 

ERR Error Logger Status LED 

Bicolor LED (Red, Green) 

OFF – No new errors or warnings. 

Green – New message logged. 

Orange – New warning logged.  

Red – New error logged. 

RST Reset LED  

Bicolor LED (Red, Green) 

Green – On startup 

OFF – Successful power-up or restart. 

Red – Power-up or restart failed. 

APPL Application LED 

Bicolor LED (Red, Green) 

OFF - No user application program in the 
Flash memory. 

Green - User application program is running. 

Orange - User application program was 
paused by user (during Hardware Test.) 

CONF Configuration LED 

Bicolor LED (Red, Green) 

OFF – Configuration was not loaded. 

Green - Configuration was loaded. 

Red - Configuration error. 

PI1 TX Plug-in Port 1 – TX 
(transmit)  

Green LED 

ON- Transmitting Data 

PI1 RX Plug-in Port 1– RX (receive) 

Green LED 

ON – Receiving Data 

PI1 CM Plug-in Port 1 – CM (channel 
monitor) 

Green LED 

ON – Channel Busy (if port is in use by radio, 
          RS485, or RS232) 
       – Network Connected (if an IP plug-in is 
          used) 

SI1 TX Serial Port 1 – TX (transmit) 

Green LED 

ON – Transmitting Data 
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LED Name Description Status 

SI1 RX Serial Port 1 – RX (receive) 

Green LED 

ON – Receiving Data 

SI1 CM Serial Port 1 – CM (channel 
monitor) 

Green LED 

ON – Channel Monitor is ON. 

S2 TX Serial Port 2 – TX (transmit) 

Green LED 

ON – Transmitting Data 

S2 RX Serial Port 2 – RX (receive) 

Green LED 

ON – Receiving Data 

S2 CM Serial Port 2 – CM (channel 
monitor) 

Green LED 

ON – Channel Monitor is ON 

E1 RX Ethernet Port 1 (receive)  

Green LED 

ON – Receiving Data 

E1 LNK Ethernet Port 1 (link)  

Green LED 

ON – Network Connected 

PI2 TX Plug-in Port 2 – TX 
(transmit) 

Green LED 

ON – Transmitting Data 

PI2 RX Plug-in Port 2 – RX (receive) 

Green LED 

ON – Receiving Data 

PI2 CM Plug-in Port 2 – CM (channel 
monitor) 

Green LED 

ON – Channel Busy (if port is in use by radio, 
          RS485, or RS232) 
       – Network Connected (if an IP plug-in is 
          used) 

USR1-
USR4 

User application program 
LEDs  

Green LED 

Controlled by the user application program. 

Light consecutively and repeatedly one after 
the other when entering boot mode. 
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CPU 3610/CPU 3640 Module Specifications 
Microprocessor Freescale – Power PC II MPC8720, 32-bit, extended communication 

capability, DMA and floating point calculation support 

Microprocessor Clock 200 MHz 

User Memory FLASH: 3 MB 
DRAM: 10MB 
Optional plug-in SRAM: 4 MB 

Real-Time Clock Full calendar with leap year support (year, month, day, hours, minutes, 
seconds, milliseconds). 
Time drift: max. 2.5 Seconds per day (when power is on) 

SRAM and RTC Retention  Rechargeable lithium backup battery 

Serial Port 1 Configurable RS232 or RS485 port: 
- RS232: Asynch, Full Flow Control, up to 230.4 kb/s, GPS receiver  
   interface 
 - RS485, multi-drop 2-Wire up to 460.8 kb/s  

Serial Port 2 RS232, Asynch, Full Flow Control, up to 230.4 kb/s, GPS receiver 
interface 

Plug-In Port 1 Supports the following Plug-In ports: 
- Radio Modem, DPSK 1.2 kb/s, FSK 2.4 kb/s, DFM 4.8 kb/s and  
  Duo-binary 9.6 kb/s 
- RS232, Sync/Asynch, Full Flow Control, up to 230.4 kb/s,  
  GPS receiver interface 
- RS485, multi-drop 2-Wire up to 460.8 kb/s 
- Ethernet 10/100 Mb/s 

Plug-In Port 2 Supports the following Plug-In ports: 

- Radio Modem (General Radio Interface) DPSK 1.2 kb/s,  
  FSK 2.4 kb/s, DFM 4.8 kb/s and Duo-binary 9.6 kb/s 
- RS232, Sync/Asynch, Full Flow Control, up to 230.4 kb/s,  
  GPS receiver interface 
- RS485, multi-drop 2-Wire up to 460.8 kb/s 
- Ethernet 10 Mb/s 

Ethernet Port 1 10/100 Mb/s, (on CPU 3640 only) 

LEDs Display 4 CPU diagnostics LEDS, Port status LEDs and user application LEDs  

Operating Voltage 9.6-16 V DC (from the motherboard connector) 

Power Consumption Max. 4.2 W (300 mA @ 14 V DC)  

Dimensions 56 mm W x 225 mm H x 180 mm D (2.2" W x 8.7" H x 7.1" D)  

Weight Approx. 0.38 Kg  (0.84 Lb) 

Specifications subject to change without notice. 
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I/O MODULES 

General Description 
The ACE3600 RTU can include up to eight I/O modules, depending on the frame size.  A 
variety of I/O modules are available. 

The I/O modules can be positioned in the slots to the right of the CPU.  As with all ACE3600 
modules, the I/O modules can be replaced while the power is on (hot swap.) 

Figure 5-1 provides a general view of an ACE3600 I/O module. 
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I/O Module with Two TBs     I/O Module with Expanded TBs 
Figure 5-1  ACE3600 I/O Module – General View 
 

Each I/O module includes an ERR status LED, individual I/O status LEDs, an array of I/O 
connectors, and a coding mechanism for the terminal cable connector or TB holder option. 

Figure 5-2 provides a detailed view of the I/O front panel. 
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Figure 5-2  ACE3600 I/O Module – Front Panel (without TB Holder) 
 

I/O Module LEDs 
The ERR LED indicates an I/O module fault and errors.  It will remain lit until all the errors 
have been eliminated.  Diagnostic and error messages can be retrieved from the module using 
the ACE3600 STS Error Logger or SW Diagnostics.  For more information, see the ACE3600 
STS User Guide. 

The I/O status LEDs in Digital Input (DI) and Digital Output (DO) modules indicate ON and 
OFF (LED lit when the I/O is ON.)  In Analog Input (AI) modules, each input has two LEDs, 
indicating Overflow (OF) and Underflow (UF).   

I/O Module Test 
The I/O modules can be tested using the STS Hardware Test utility.  For more information, see 
the ACE3600 STS User Guide. 

The I/O module LEDs can be tested using the STS Hardware Test utility– all the LEDS are lit 
for a number of seconds, and then turned back to their previous state. 

Panel Terminal Block (TB) Connectors 
TB connectors have a fixed female side on the module and a male plug for the sensor/device 
wire connection.  The TB male side in all modules is screw type for up to 1mm (18 AWG) 
wire.  An optional TB extractor is available for easy removal of TBs. 
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TB Holder and Cables 
The TB holder secures the male TBs neatly in place and forms a single connector plug per 
module.  The wires connected to the TBs are concealed in the holder.  The module and the TB 
holder provide a coding mechanism to prevent cabling errors.  Extractor handles enable easy 
release of the TB holder connector from the module.  An optional three-meter cable braid, 
completely wired with holder and cable, is available.  

A TB holder kit is available to enable self-assembly of cables.  User assembled cables should 
use wires of up to 0.4mm (26 AWG).  The TB holder kit does not include a cable. 

 

               Figure 5-3  Terminal Block (TB) Holder-Front and Back View 

Assembling the TB Holder Parts 
Procedure 5-1  Assembling the TB Holder Parts  

If the TB holder kit is ordered, follow the procedure below: (See Figure 5-4) 

1) Prepare the cable by cutting the wires to fit the TBs.  Connect the wires of the user-
assembled cables to the TBs, following the pin descriptions on the module panel label 
(where pin 1 is at the top of first TB and so on downwards.) 

2) Place the TBs onto the left part of the TB holder plastic.  . 

3) Add the top extractor handle, the code key and the positioner.   

4) Close the right side of the plastic TB holder over the left side.  

5) Screw together the assembly using the three screws provided in the kit.     
Note the lower screw holds the positioner into place.) 

6) Insert the lower extractor handle at the bottom of the TB holder.   

7) Slide the metal axis into lower extractor handle from the side.   

Once the TB holder is assembled, it can be connected to the I/O module. 
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Figure 5-4 provides an exploded view of the TB holder assembly. 

 

Figure 5-4  Terminal Block (TB) Holder Assembly – Exploded View with Coding 

Attaching the TB Holder Clip to the I/O Module 
An optional TB holder clip can be added to the I/O module to secure the cable. 

Procedure 5-2  Attaching the TB Holder Clip to the I/O Module 

1) Remove the I/O module from the ACE3600 RTU. 

2) Using the supplied screw, attach the TB holder clip to the bottom of the I/O module.  (see 
Figure 5-5) 
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3) Replace the I/O module in the RTU slot. 

I/O Module

Cable Pipe

TB Holder 
Clip Screw

TB Holder 
Clip 

 

Figure 5-5  I/O Module with Terminal Block (TB) Holder Clip  

Connecting the TB Holder to the I/O Module 
Procedure 5-3  Connecting the TB Holder to the I/O Module 

1) Open the door of the I/O module. 

2) On the TB holder, loosen the screw and turn the positioner so that the arrow points to 
either A or B.   

3) Tighten the screw. 

4) With a screw driver, set the code key pin to a number from 1 to 6.   

5) On the I/O module, using a screwdriver, set the pin to the same number (from 1 to 6.)  This 
ensures that the TB holder will not be accidentally connected to the wrong I/O module. 

6) Slide the plastic lip on the bottom of the I/O module to either A (up) or B (down) (as in 
Step 2).  

7) Align the plastic lip with the flat edge of positioner on the TB holder and snap the TB 
holder into the I/O module, (see Figure 5-6), fitting the code key pin into the code key. 

8) If the extractor handles are extended, push them inwards, against the TB holder (see Figure 
5-6.) 

9) If a TB holder clip was attached to the I/O module, slide the cable between the two edges 
of the clip, and press the clip closed to secure the TB holder to the module. See Figure 5-5. 

10) Label the TBs wires with any desired user notes.  The wires are numbered 1-20 or 1-40 
depending on the model.  The wire numbers correspond to the module pins. 

11) To extract the TB holder from the I/O module front panel, extend the ejector/extractor 
handles outward away from the module and pull on the handles. 
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Figure 5-6 provides a general view of the TB holder and an I/O module. 

TB Holder

Terminal 
Blocks (TB)

Extractor
Handles

Code Key 

OF

OF

UF
16

24V

Positioner

Terminal Block (TB)

I/O Module

Code Key 

Positioner

Terminal Block (TB)

TB Holder

Screw 

I/O Module

 
 

Figure 5-6  Terminal Block (TB) Holder on I/O Module – General View with Coding 

User Label 
Each I/O module is provided with a blank label on the module door for user notes. 

Inserting/Removing an I/O Module from the Rack 
I/O modules support hot-swap and can be inserted and extracted while the system is powered 
up.  For instructions on removing/inserting an I/O module from/into a rack, see the Replacing 
an I/O Module section of the Break-Fix Procedures chapter below. 

Automatic Module ID 
Each I/O module has a unique module type ID number.  When the RTU is powered up or when 
an I/O module is inserted into a slot (hot-swap), the CPU automatically identifies the module 
type.   

The module ID can be viewed from the STS Hardware Test utility.  For more information, see 
the Hardware Test section of the ACE STS User Guide. 
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24V DC Floating Plug-In Power Supply 
*Future option* 

Up to two 24V DC floating plug-in power supplies can be added to certain I/O modules, as 
detailed in the table below. 

Table 5-1  Number of Plug-In Power Supplies in ACE3600 I/O Modules  
 

Module Type Number of Power 
Supplies 

32 DI 2 

16 DI 1 

16 AI 1 

8 AI 1 

Mixed I/O 1 

 
The plug-in power supply is ordered separately.   

Procedure 5-4  Attaching the Power Supply to the I/O Module  

Attach the power supply to the I/O module using the following procedure: 

1) Put the plastic screw(s) in the hole(s) from under the board.  

2) Screw the plastic spacer(s) onto the plastic screw(s). 

3) Place the plug-in over the spacer(s). 

4) Screw the top plastic screw into the spacer(s) to secure the plug-in.    
The RTU will automatically recognize the 24V power supply. 

Each plug-in power supply output is controlled by the CPU module.  By default, the plug-in 
power supply is ON and can supply up to 350mA.  The power supply plug-in can be turned 
ON/OFF via the user application program or Hardware Test utility.   

Figure 5-7 provides a general view of an I/O module with one plug-in. 
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Figure 5-7 ACE3600 I/O Module – General View 
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DIGITAL INPUT MODULE 

General Description 
The ACE3600 Digital Input (DI) module can have 16 or 32 inputs. 

The following DI modules are available. 

• 16 DI Fast 24V  

• 32 DI Fast 24V  

• 16 DI Fast 24V IEC TYPE 2  

• 32 DI Fast 24V IEC TYPE 2 

Two types of voltage (“wet”) inputs are supported, IEC 61131-2 Type II compliant inputs and 
24V “MOSCAD compatible” inputs.  In the 32 DI module, the first 20 inputs can function as 
fast counters. In the 16 DI module, all inputs can function as fast counters.  A counter's 
maximum rate is dependent on the module type (see the specifications below.)  

All the inputs are optically isolated.  The DI modules support optional 24V DC floating plug-in 
power supplies (for contact “wetting” or other purposes). 

Each DI can be an event trigger (interrupt-driven) to a high priority fast process.  The high 
priority fast process enables very fast activation of an output in response to an input trigger and 
logical conditions.  This high priority fast process is not dependent on the I/O scan (refer to the 
STS Application Programmer manual.) 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. 

Figure 6-1 provides a general view of the ACE3600 DI module. 
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16 DI Module       32 DI Module  
Figure 6-1  ACE3600 DI Module – General View 

 

Figure 6-2 provides a detailed view of the ACE3600 DI module front panel. 
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16 DI Module   32 DI Module  
Figure 6-2  ACE3600 DI Module – Front Panel 

 

DI Module Configuration 
The 16 DI Fast 24V and 32 DI Fast 24V modules can handle AC and DC input signals. The 
user can select DC or AC operation per module. When AC configuration is selected, the Fast 
Capture, Counter Function and Input Filters (see below) are disabled. 

Fast Capture (DC Configuration) 
When the DI module is in DC mode, each DI can be configured as a Fast Capture DI.  Fast 
capture causes the SCAN ladder output operation to get the first change that occurred since the 
previous scan. When fast capture is disabled, the scan gets the current value of the DI (in this 
case, any DI changes between scans are missed.) 

Input Filters (DC Configuration) 
When the DI module is in DC mode, each input has a HW input filter to make sure that the 
input reading is stable.  The range of the HW DI filter is  0 to 50.8 millisecond (in 0.2 mS 
steps). The Fast Counter DI filter range is 0 to 12.75 millisecond (in 0.05 mS steps).   

Event Time Tagging  
Each DI can be set in the user application program’s I/O link table to trigger recording of time 
tagged events upon any input change of state.  The time tagged events are recorded in the CPU 
memory and can be retrieved for various purposes.   
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Keep Last Value (KLV) and Predefined Value (PDV) 
Each input can be configured to KLV or to a PDV (0, 1). This value is shown to the user 
application program in the event of DI module failure.  The PDV can also be used during 
normal operation to force a value that masks the actual input value.  In this case the user 
program will get the PDV instead of the actual input value.  

DI Module Configuration Options 
The DI module features which can be configured are listed in the table below. Some parameters 
are per module and some are per input. 

Table 6-1  ACE3600 DI Module Configurable Features  
 

Feature Parameter 
Settings 

Default Setting Per Module / 
Input 

Parameter Setup 
Location 

DC or AC 
operation∗ 

AC / DC DC Module STS site 
configuration 

Fast Capture Disabled 
/Enabled 

Disabled Input STS site 
configuration 

DI Filter (DC) 0-254 (x 0.2 
mS) 

50 (10 mS) Module STS site 
configuration; 
‘C’ User Program 

Counter Filter 
(DC) 

0-255 (x 0.05 
mS) 

20 (1 ms) Module STS site 
configuration 
‘C’ User Program 

Event Time 
Tagging 

Disabled/ 
Enabled 

Disabled Input User Program I/O 
link table 

Keep Last Value 
and Predefined 
Value 

KLV/PDV 
PDV=0/1 

KLV Input User Program I/O 
link table 

Mask No /Yes No Input User Program I/O 
link table 

Sleep Mode 
Each DI module can be switched by the user application program to Sleep Mode.  In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode, the user application program will get the predefined values (PDV) for each I/O. 

                                                      
∗ in Fast 24V IEC TYPE II modules –only DC 
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Module Status and Diagnostics 
In the event of DI Module failure, the I/O module ERR LED will be lit.  This event is 
registered by the CPU in the Error Logger.  DI Module failure status is also visible to the user 
application program.  

The DI module can be diagnosed and monitored using the STS Hardware Test utility. This test 
verifies that the module is operational, presents the module configuration and shows the actual 
value of each input. It is also possible to change the input filter setup temporarily for the 
duration of the Hardware Test. 

In the Hardware Test utility, it is possible to set the DI module to Freeze Mode. In this mode 
the user application program will get the predefined value of each input in the module, instead 
of the actual input value. Freeze mode enables testing the inputs while the user application 
program is running. 

For details on configuring the DI modules, see the Site Configuration section, and the 
Application Programming section of the STS User Guide. 
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Module Block Diagram 
16 DI 
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32 DI 
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DI Module Specifications 
16/32 DI FAST 24V Module  

Total Number of Inputs 16 DI   (Option V265); 32 DI   (Option V379) 

Input Arrangement Isolated groups of 16 inputs with shared common  

Fast Counter Inputs Inputs that can be used as fast counter: 
- All inputs in 16 DI module; - First 20 inputs in 32 DI module 

AC Input Frequency 45 – 65 Hz 

AC Input Delay Maximum 0.2 mS 

Fast Counter Input Frequency 0 - 12.5 KHz, minimum pulse width 40  µS 

Max. DC Input Voltage Max. ±40 V DC (relative to input common) 

“ON” DC Voltage Range +9 to +30 V DC,  -9 to -30 V DC 

“OFF” DC Voltage Range -3 to +3 V DC 

“ON” AC Voltage Range 10 to 27 V AC (RMS) 

“OFF” AC Voltage Range 0 to 5 V AC (RMS) 

Input Current Max. 2.5 mA 

Fast Capture Resolution 1 mS (Interrupt upon change of state) 

Event Time Tagging Resolution 1 mS (Interrupt upon change of state) 

Input Filtering 0 to 50.8 mS (DC, programmable in 0.2 mSec steps) 

Counter Input Filtering 0 to 12.75 mS (programmable in 0.05 mSec steps for inputs configured 
as high speed counter) 

24 V DC Output Supports optional isolated 24 V/0.35 A plug-in “Wetting” Power 
Supply (one in 16 DI, two in 32 DI) 

Diagnostics LEDs Status LED per each input, module error LED 

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG 

Cable and TB Holder 20 or 40 Wire Cable with TB Holder connector, 26 AWG wires 

Module Replacement Hot swap replacement – module extraction / insertion under voltage 

Input Isolation 2.5 kV DC/AC between input and module logic per IEC255-5 

Input Insulation Insulation resistance 100 MΩ @ 500 V DC,  
Insulation impulse 5 kV per IEC255-5 

Operating Voltage 10.5-15.5 V DC and 3.3 V DC (from the motherboard connector) 

Power Consumption 16 DI: 0.1 W Typical, 0.32 W Max. (all LEDs on) 
32 DI: 0.1 W Typical, 0.45 W Max. (all LEDs on) 
(Not including Plug-in 24 V Power Supply power consumption) 

Dimensions 37 mm W x 225 mm H  x 180 mm D, (1.5“ W x 8.7“ H x  7.1“ D) 

Weight 16 DI: approx. 0.28 Kg  (0.62 lb); 32 DI: approx. 0.29 Kg (0.63 lb) 
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16/32 DI FAST 24V IEC 61131-2 TYPE II Module 

Total Number of Inputs 16 DI   (Option V117) 
32 DI   (Option V959) 

Input Arrangement Isolated groups of 16 inputs with shared common  

Fast Counter Inputs Inputs that can be used as fast counter: 
- All inputs in 16 DI module 
- First 20 inputs in 32 DI module 

Fast Counter Input Frequency 0 - 10 KHz, minimum pulse width 40  µS 

Max. DC Input Voltage Max. ±40 V DC (relative to input common) 

“ON” DC Voltage Range +11 to +30 V DC 

“OFF” DC Voltage Range -5 to +5 V DC 

Input Current 6-10 mA 

Fast Capture Resolution 1 mS (Interrupt upon change of state) 

Event Time Tagging Resolution 1 mS (Interrupt upon change of state) 

Input Filtering 0 to 50.8 mS (DC, programmable in 0.2 mSec steps) 

Counter Input Filtering 0 to 12.75 mS (programmable in 0.05 mSec steps for inputs configured 
as high speed counter) 

24V DC Output Supports optional isolated 24 V/0.35 A plug-in “Wetting” Power 
Supply (one in 16 DI, two in 32 DI) 

Diagnostics LEDs Status LED per each input, module error LED 

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG 

Cable and TB Holder 20 or 40 Wires Cable with Terminal Block Holder connector, 26 
AWG wires 

Module Replacement Hot swap replacement – module extraction / insertion under voltage 

Input Isolation 2.5 kV DC/AC between input and module logic per IEC255-5 

Input Insulation Insulation resistance 100 MΩ @ 500 V DC,  
Insulation impulse 5 kV per IEC255-5 

Operating Voltage 10.5-15.5 V DC and 3.3 V DC (from the motherboard connector) 

Power Consumption 16 DI: 0.1 W Typical, 0.32 W Max. (all LEDs on) 
32 DI: 0.1 W Typical, 0.45 W Max. (all LEDs on) 
(Not including Plug-in 24V Power Supply power consumption) 

Dimensions 37 mm W x 225 mm H  x 180 mm D, (1.5“ W x 8.7“ H x  7.1“ D) 

Weight 16 DI: approx. 0.28 Kg  (0.62 lb) 
32 DI: approx. 0.29 Kg (0.63 lb) 

Specifications subject to change without notice. 
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DIGITAL OUTPUT/DIGITAL INPUT FET MODULE 

General Description 
The Digital Output/Digital Input (DO/DI) FET module has 16 or 32 configurable user 
connections, organized in four groups.  Each group can be configured as an 8 DO group or as 
an 8 DI group.  

The following Digital Output/Digital Input (DO/DI) FET modules are available. 

• 16 (DO/DI) FET 

• 32 (DO/DI) FET 

The outputs are optically isolated current sink FET type with back indication. The inputs are 
optically isolated Dry Contact type with internal “wetting” voltage. 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. 

Figure 7-1 provides a general view of the ACE3600 DO/DI FET module. 

                        

    16 DO/DI FET Module   32 DO/DI FET Module 
    Figure 7-1  ACE3600 DO/DI FET Module – General View  
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Figure 7-2 provides a detailed view of the ACE3600 DO/DI FET module front panel. 

                               

16 DO/DI FET Module   32 DO/DI FET Module 
                     Figure 7-2  ACE3600 DO/DI FET Module – Front Panel 

Module Configuration 

Input/Output 
The following combinations can be configured in the STS site configuration (16 DO/DI). 

I/O combination DI location DO location 

16DO - 1-16 

8DI  + 8DO 1-8 9-16 

16DI 1-16 - 
 

The following combinations can be configured in the STS site configuration (32 DO/DI). 

I/O combination DI location DO location 

32DO - 1-32 

8DI  + 24DO 1-8 9-32 

16DI + 16DO 1-16 17-32 

24DI + 8DO 1-24 25-32 

32DI 1-32 - 
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The appropriate combination is selected as the I/O module type, when configuring the I/Os in 
the ACE3600 STS site configuration.  

DI Fast Capture 
Each DI can be configured as Fast Capture DI in the STS advanced I/O configuration. Fast 
capture causes the SCAN ladder output operation to get the first change that occurred since the 
previous scan. When fast capture is disabled (default), the scan gets the current value of the DI 
(in this case DI changes between scans are missed). 

DI Input Filters  
Each inputs has a hardware input filter to make sure that the input reading is stable. The 
hardware DI filter range is 0 to 50.8 mS (in 0.2 mS steps).  Counter DI filter range is 0 to 12.75 
mS (in 0.05 mS steps).  The DI filter can be set in the STS advanced I/O configuration. 

DI Event Time Tagging  
Each DI can be set in the Application Programmer I/O link table to trigger recording of time 
tagged events upon any input change of state. The time tagged events are recorded in the CPU 
memory and can be retrieved for various purposes.   

DI Keep Last Value (KLV) and Predefined Value (PDV)  
Each input can be configured to KLV or to a PDV (0, 1) in the Application Programmer I/O 
link table. This value is shown to the user application program in the event of DI module 
failure. Also, the predefined value can be used during normal operation to force a value that 
masks the actual input value.  In this case the user application program will get the PDV 
instead of the actual input value.  

DO Keep Last Value (KLV) and Predefined Value (PDV)  
Each output can be configured to KLV or to a PDV (0, 1). This value is executed when the user 
application program stops or when the module has no communication with the CPU module. 
Also, the predefined value can be used during normal operation to force a value on the output 
by ignoring the user application program value.   

DO/DI FET Module Configuration Options 
The DO/DI FET module features which can be configured are listed in the table below. Some 
parameters are per module and some are per input. 
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Table 7-1  ACE3600 DO/DI FET Module Configurable Features  
 

Parameter Selection Default Setup Per Module/ 
Input 

Parameter 
Setup Location 

DI Fast Capture Disabled 
/Enabled 

Disabled Input RTU 
configuration 

DI Filter 0-254 (x 0.2 mS) 50 (10 mS) Module RTU 
configuration;  
‘C’ Program 

DI Counter 
Filter 

0-255 (x 0.05 mS) 20 (1 ms) Module RTU 
configuration; 
‘C’ Program 

DI Event Time 
Tagging 

Disabled 
/Enabled 

Disabled Input Application 
Programmer I/O 
link table 

DI Keep Last 
Value & 
Predefined 
Value 

KLV/PDV 

PDV = 0/1 

KLV Input Application 
Programmer I/O 
link table 

DI Mask No /Yes No Input Application 
Programmer I/O 
link table 

DO Keep Last 
Value & 
Predefined 
Value 

KLV/PDV 

PDV = 0/1 

KLV Output Application 
Programmer I/O 
link table 

DO Mask No /Yes No Output Application 
Programmer I/O 
link table 

Sleep Mode 
Each DO/DI module can be switched by the user application program to Sleep Mode. In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode, the user application program will get the KLV or PDV per each DI. 

Module Status and Diagnostics 
In the event of a DO/DI module failure, the ERR LED on the module will be lit.  This event is 
registered by the CPU in the Error Logger.  DO/DI module failure status is also visible to the 
user application program. 

The DO/DI module can be diagnosed and monitored using the STS Hardware Test utility.  The 
Hardware Test verifies that the module is operational, presents the module configuration and 
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shows the actual value of each input and output.  It is also possible to change the input filter 
setup for the duration of the Hardware test and change the value of the DOs. 

In the Hardware Test utility, it is possible to set the module to Freeze Mode. In this mode the 
user application program will get the KLV/PDV of each input in the module instead of the 
actual input value. The DO values will keep the last value they had when the module was 
switched to Freeze Mode. Freeze mode enables testing the inputs and outputs while the user 
application program is running. 

Module Block Diagram 
16 DO/DI FET 
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32 DO/DI FET 
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DO/DI FET Module Specifications 
Total Number of I/Os 16  (Option V480); 32  (Option V481) 

I/O Arrangement Two or four group of 8 I/Os with shared common 
Each group can be configured as FET DO or dry contact DI 
Selectable combinations (32 DO/DI): 32 DO/8 DI+24 DO/ 
16 DI+16 DO/24 DI+8 DO/32 DI 
Selectable combinations (16 DO/DI): 16 DO/8 DI+8 DO/16 DI+16 DI 

Counter Inputs 20 first inputs can be used as counter inputs  

Counter Input Frequency 0 - 1 KHz, minimum pulse width 500 µS.  Note: Although filters are 
defined in steps of 0.2mSec and 0.05mSec, it is relevant only from 1mSec 
and above. 

Max. DC Input Voltage Max. 30 V DC (relative to input common) 

Input “ON” Resistance 0-4 kΩ  

Input “OFF” Resistance ≥50 kΩ  

Fast Capture Resolution 1 mS (Interrupt upon change of state)  

Event Time Tagging Resolution 1 mS (Interrupt upon change of state)   

Input Current Max. 0.3 mA (when the input is shorted)  

Input Filtering 0 to 50.8 mS (programmable in 0.2 mSec steps) 

Counter Input Filtering 0 to 12.75 mS (programmable in 0.05 mSec steps)  

Output Type MOSFET  

Output Voltage Range 5-30 V DC (user supplied voltage) 

DO Frequency Max. 1 KHz (resistive load)  

DO Output Current Max. 500 mA sink current (resistive load) 

Output Fail State Configurable output state on CPU fail: On, Off or ‘last value’  

Diagnostics LEDs LED per each input / output status, module error LED  

User Connection 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  

Cable and TB Holder 40 Wire Cable with Terminal Block Holder connector, 26 AWG  

Module Replacement Hot swap replacement– module extraction / insertion under voltage 

Input / Output Isolation  2.5 kV between input/output and module logic 

Input Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5 

Operating Voltage 10.5-15.5 V DC and 3.3 V DC (from the motherboard connector)  

Power Consumption 0.1 W Typical, 0.5 W max. (all LEDs on) 

Dimensions 37 mm W x 225 mm H  x 180 mm D        
(1.5" W x 8.7" H x  7.1" D) 

Weight Approx. 0.25 Kg  (0.55 lb) 

Specifications subject to change without notice. 
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DIGITAL OUTPUT RELAY MODULE 

General Description 
The DO Relay modules have 8 or 16 outputs.  

There are two types of DO relays: 

• Electrically Energized (EE) - the outputs return to the non-energized state in case of power 
off or module failure. 

• Magnetically Latched (ML) - Relay outputs are magnetically latched, the outputs maintain 
their state in case of power off or module failure. 

The following DO relays modules are available:  

• 8 DO EE Relay 2A  

• 16 DO EE Relay 2A  

• 8 DO ML Relay 2A  

• 16 DO ML Relay 2A  

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. 

Figure 8-1 provides a general view of the ACE3600 DO Relay Module. 
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8DO Relay       16 DO Relay 
Figure 8-1  ACE3600 DO Relay Module – General View 
 

Figure 8-2 provides a detailed view of the ACE3600 DO Relay Module front panel. 

                                 

8DO Relay   16DO Relay 
Figure 8-2  ACE3600 I/O Module – Front Panel 



Digital Output Relay Module 

8-3 

In the 8 DO modules, the relays of outputs 1 through 5 are Single Pole Single Throw (SPST) 
normally open (NO) and are referred to as the “Form A” relays.  The relays of outputs 6 
through 8 are Single Pole Double Throw (SPDT) and are referred to as the “Form C” relays. 

In the 16 DO modules, the relays of outputs 1 through 5 and 9 through 13 are Single Pole 
Single Throw (SPST) normally open (NO) “Form A” relays. The relays of outputs 6 through 8 
and 14 through 16 are Single Pole Double Throw (SPDT) “Form C” relays. 

The physical position of each relay is monitored by the module logic, using a back indication 
signal which is connected to the relay’s second contact set.  Any contradiction between the 
required position and the back indication signal is reported to the CPU and is available to the 
user program.  

In some applications it is necessary to inhibit relay output operation when attending the site for 
safety reasons.  In all DO relay modules, it is possible to inhibit all relays per DO module. 
When a module is configured to enable relay inhibiting, the power to the relays is provided 
from the power supply via a dedicated power line (12V DO), controlled from the “12V DO” 
input (TB located on the power supply module panel).  When the input’s terminals are shorted, 
the relays are operational.  When the input’s terminals are open, the relays are inhibited (EE 
relays in 0 position and ML relays do not change state.) 

The user program can monitor the relay inhibiting status and act accordingly.  Also, when the 
module’s relays are inhibited, any mismatch between the relay position and the output logical 
state is ignored. 

Module Configuration 

Relay Inhibiting 

 

When the dipswitch is set to 12V DO, the position of the 2-pin 12V DO 
Control connector on the front panel of the power supply module (see 
Power Supply Module chapter above) acts as a safety mechanism.  When 
the 2-pin TB is unplugged from the 12V DO Control (e.g. for maintenance), 
power is not supplied via the motherboard to the relays and the relays are 
disabled.  The 12V DO affects all relays in the system that are programmed 
to work from the 12V DO and not the (default) 12V Main. 
 
EE relays that are programmed for 12V DO operation will disconnect when 
12V DO power is shut down and cannot be changed in this state.   
ML relays that are programmed for 12V DO operation will freeze in their 
current state when 12V DO power is shut down and cannot be changed. 
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A dual selector dipswitch (S3) on the DO Relay module has 4 selectable positions as described 
in the following table: 

Table 8-1  DO Relay Module- Dipswitch Settings 
S3 
SW 1 

S3  
SW 2 

Configuration mode 

O (OFF) N (OFF) 12V_DO – Relay inhibiting enabled 

1  (ON) N (OFF) Software selectable – inhibiting is set in site configuration 

O (OFF) 2  (ON) 12_DO– Relay inhibiting enabled 

1  (ON) 2  (ON) 12 V – (factory default) Relay inhibiting disabled 
 

O
N

1
2

 

Figure 8-3  12V DO Dipswitch 

 

When S3 is set to Software Selectable mode, the inhibiting configuration is set using the 
module configuration in the STS Site Configuration (see Table 8-2 below). 

Procedure 8-1 describes how to set the 12V DO dipswitch to enable relay inhibiting. 

Procedure 8-1  How to Set the 12V DO Dipswitch to Enable Relay Inhibiting. 

1) If the 2-pin TB is plugged into the 12V DO Control on the front panel of the power supply 
module, unplug it.  

2) Remove the DO module from the slot in the rack. 
3) Carefully remove the plastic wrap covering from the S3 dipswitch (see Figure 8-3) on the 

DO module board.  
4) Set the S3 dipswitch to the desired position, according to the legend in Table 8-1.   
5) Replace the DO module in the rack. 
6) If the new dipswitch position causes DO relay power to be drawn from the 12VDO, plug 

the 2-pin TB back into the 12V DO Control on the front panel of the power supply module. 

DO Keep Last Value (KLV) and Predefined Value (PDV)  
Each output can be configured to KLV or to a PDV (0, 1).  This value is executed when the 
user program stops or when the module has no communication with the CPU module. Also, the 
PDV can be used during normal operation to force a value on the output by ignoring the user 
program value (mask).   
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Reset DO at Startup 
It is possible to configure the module to reset all the ML relays positions on startup.  This is set 
in the STS site configuration. 

Table 8-2  ACE3600 DO Relay Module Configurable Features  
 

Parameter Selection Default Setup Per Module/ 
Input 

Parameter 
Setup Location 

DO Keep Last 
Value & Pre 
Defined Value 

KLV/PDV 
PDV = 0/1 

KLV Output Program I/O link 
table 

DO Mask No /Yes No Output Program I/O link 
table 

Reset DO at 
Startup 

Disable/Enable Disable Module Site 
configuration 

Relay Inhibiting 
(SW selectable) 

Disable/Enable Disable Module Site 
configuration 

 

Sleep Mode 
Each DO module can be switched by the user program to Sleep Mode. In Sleep Mode, the 
module is not functioning and the power consumption is minimized.  

Module Status and Diagnostics  
In the event of module failure, the module’s ERR LED will be lit.  This event is registered by 
the CPU in the Error Logger.  Module failure status is also visible to the user program.  

The DO module can be diagnosed and monitored using the STS Hardware Test utility. This test 
verifies that the module is operational, presents the module configuration and shows the actual 
value of each output. It is also possible to change the DO’s value. 

In the Hardware Test utility, it is possible to set the module to Freeze Mode. In this mode, the 
DOs will keep the last value they had at the time they were frozen.  Freeze mode enables 
testing the inputs and outputs while the user program is running. 

For details on configuring the DO modules, see the Configuring a Site section and the 
Application Programmer section of the ACE3600 STS User Guide. 
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Module Block Diagram 
8 DO 
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16 DO 
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DO Relay Module Specifications 
Total Number of Outputs 8 EE relay outputs (Option V508)  

16 EE relay outputs (Option V616) 

8 ML relay outputs (Option V314)  

16 ML relay outputs (Option V516) 

Output Arrangement 8 DO : 3 X Form C (SPDT) and 5 X Form A (SPST) 

16 DO: 6 X Form C (SPDT) and 10 X Form A (SPST) 

Contact Voltage Ratings Max. 60 V DC or 30 V AC RMS (42.4 V peak).  

Contact Power Ratings 2A @ 30 V DC, 0.6A @ 60V DC or 0.6A @ 30V AC (resistive load) 

Relay Back Indication Contact position - hardware back indication 

DO Frequency Max. 10 Hz  

Diagnostics LEDs LED per each output status, module error LED  

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  

Cable and TB Holder 20 or 40 Wire Cable with Terminal Block Holder connector, 26 AWG  

Fail State Configurable relay state on CPU fail: On, Off or ‘last value’  

All Relays Disable/Enable Selectable per module, controlled from the power supply  

Module Replacement Hot swap replacement – module extraction / insertion under voltage  

Output Isolation  Between open contacts: 1kV,  
Between contact and coil: 1.5 kV,  
Between contact sets: 1.5 kV 

Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5,  
Insulation impulse 1.5 kV between input and logic 

Operating Voltage 10.5-15.5 V DC and 3.3 V DC (from the motherboard connector)  

Power Consumption 8 D0: 0.25 W Typical,  
     EE: 1.4 W max. (all relays and LEDs on),  
     ML: 0.4 W (LEDs on)  

16 D0: 0.25 W Typical,  
     EE: 2.5 W max. (all relays and LEDs on),  
     ML: 0.5 W (LEDs on) 

Dimensions 37 mm W x 225 mm H  x 180 mm D  
(1.5" W x 8.7" H x  7.1" D)  

Weight 8 DO  : approx. 0.29 Kg (0.64 lb)  
16 DO: approx. 0.32 Kg (0.7 lb) 

 

Specifications subject to change without notice. 
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ANALOG INPUT MODULE 

General Description 
The Analog Input (AI) modules have 8 or 16 inputs.  The modules sample and convert analog 
data into digital format and transfer the digital data to the CPU module.   

The following modules are available: 

• 8 AI,  ±20 mA (supports 4-20 mA)  

• 16 AI,  ±20 mA (supports 4-20 mA) 

• 8 AI,  ±5 V (supports 0-5 V and 1-5 V)  

• 16 AI,  ±5 V (supports 0-5 V and 1-5 V) 

The module’s analog-to-digital conversion resolution is 16 bit (including sign). Each input is 
fully isolated from the other inputs on the module and also optically isolated from the module 
internal circuits. The modules are fully calibrated and can be tested and recalibrated in the 
field. 

The measured values are digitally filtered to reduce the 50 or 60 Hz noise. The user can select 
the filtering frequency per module. 

The measured values can be smoothed by digital filtering. Smoothing is accomplished by 
calculating the running average values of a defined number of converted analog values 
(samples). The user can select the level of smoothing per module. The higher the smoothing 
level chosen, the more stable is the smoothed analog value and the longer it takes until the 
smoothed analog signal is applied after a step response.  

The user can select how the analog values are represented to the user application program as 
unit-less numeric values or as scaled values that represent certain Engineering Units (EGU).  

Each AI module can include an optional plug-in floating 24V DC power supply to power 
external devices.  

Each analog input has two status LEDs: 

• UF - indicates Underflow when lit 

• OF - indicates Overflow when lit 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. 

For details on specific AI parameters and configuration, see AI Module Configuration below. 
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Figure 9-1 provides a general view of the ACE3600 AI module. 
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Figure 9-1  ACE3600 AI Module – General View 
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Figure 9-2 provides a detailed view of the AI module front panel. 
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Figure 9-2  ACE3600 I/O Module – Front Panel 
 

AI Module Configuration 

50/60 Hz Filtering 
This parameter enables the user to configure the module to use 50 or 60 Hz filter on all inputs. 

AI Filter (Smoothing) 
This parameter enables the user to configure the level smoothing (averaging) on all inputs. It 
can be set to 1, 2, 4, 8, 16, 32, 64,128 samples. 

Change Of State (COS) Delta 
This parameter sets a delta value to each input.  This enables the user application program to 
get an indication when the input value change is more than ± delta value. 

Input Range 
This parameter sets the overflow and underflow limits (refer to AI Module value representation 
below.) 
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In the current input modules, the ranges that can be selected are: ±20 mA (default) and 4-20 
mA.  

In voltage input modules, the ranges that can be selected are ± 5V (default), 0-5 V and 1-5 V. 

Keep Last Value (KLV) and  Predefined Value (PDV)  
Each input can be configured to KLV or to a PDV.  This value is shown to the user application 
program in the event of AI module failure. The predefined value can also be used during 
normal operation to force a value that masks the actual input value.  In this case the program 
user will get the PDV instead of the actual input value.  

AI Module Configuration Options 
The AI module features which can be configured are listed in the table below. Some parameters 
are per module and some are per input. 

Table 9-1  ACE3600 AI Module Configurable Parameters  
 

Parameter Selection Default setup Per Module / 
Input 

Parameter 
Setup location 

50/60 Hz 
Filtering 

50/60 50 Hz Module STS Site 
configuration 

AI Filter 
(Smoothing) 

2/4/8/16/32/64/128 32 Module STS Site 
configuration 

Input Range Current: ±20 mA/ 
4-20 mA 
Voltage: ±5 V/0-5V/ 
1-5V 

Current: ±20 mA 

Voltage: ±5 V 

Module STS Site 
configuration 

COS Delta value 0 (disabled) Input Application 
Programmer I/O 
link table 

KLV & PDV KLV/PDV 

PDV=value 

KLV Input Application 
Programmer I/O 
link table 

Mask No /Yes No Input Application 
Programmer I/O 
link table 

Sleep Mode 
Each AI module can be switched by the user application program to Sleep Mode. In Sleep 
Mode, the module does not function and the power consumption is minimized. During Sleep 
mode the user application program will get the predefined values for each I/O. 
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Module Status and Diagnostics 
In the event of AI Module failure, the I/O module ERR LED will be lit.  The event is registered 
by the CPU in the Error Logger.  AI Module failure status is also visible to the user application 
program.  

In addition to the ERR LED, the module includes an Underflow (UDF) and Overflow (OVF) 
LED for each input.  

• When the UDF LED is lit, it indicates that the signal level in the corresponding input is below 
the nominal range.  

• When the OVF LED is lit, this indicates that the signal level in the corresponding AI is above 
the nominal range.  

• If both the UDF and OVF LEDs of the same channel are lit, the channel is uncalibrated.  

The AI module can be diagnosed and monitored using the STS Hardware Test utility. The 
Hardware Test verifies that the module is operational, presents the module configuration and 
shows the actual value of each input, including overflow and underflow.  It is also possible to 
change the input filter setup for the duration of the Hardware test. 

In the HW Test utility, it is possible to set the AI module to Freeze Mode. In this mode the 
program user will get the KLV or PDV of each input in the module instead of the actual input 
value. Freeze mode enables testing the inputs while the user application program is running. 

AI Module Value Representation 
In ± 20 mA 

current inputs 
Decimal Value Input Current Indication 

 < -32256 < -20.16 mA Underflow LED ON 

 -32000 -20 mA 

 0 0 mA 

 32000 +20 mA 

 

Rated range (no LED 
active) 

 > 32256 > +20.16 mA Overflow LED ON 
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In 4 - 20 mA 
current inputs 

Decimal Value Input Current Indication 

 < 6144 < 3.84 mA Underflow LED ON 

 6400 +4 mA 

 0 0 mA 

 32000 +20 mA 

 

Rated range (no LED 
active) 

 > 32256 > +20.16 mA Overflow LED ON 

    

In ± 5 V current 
inputs 

Decimal Value Input Voltage Indication 

 < -32256 <-5.04V Underflow LED ON 

 -32000 -5 V 

 0 0 V 

 32000 +5 V 

 

Rated range (no LED 
active) 

 > 32256 > +5.04 V Overflow LED ON 

    

In 0 - 5 V 
current inputs 

Decimal Value Input Voltage Indication 

 < -256 < -0.04 V Underflow LED ON 

 0 0 V 

 32000 +5 V 

Rated range (no LED 
active) 

 > 32256 > +5.04 V Overflow LED ON 

    

In 1 - 5 V 
current inputs 

Decimal Value Input Voltage Indication 

 < 6144 < 0.96 V Underflow LED ON 

 6400 1 V 

 32000 +5 V 

Rated range (no LED 
active) 

 > 32256 > 5.04 V Overflow LED ON 
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Module Block Diagram 
8 AI 
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16 AI 
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AI Module Specifications 
Total Number of Inputs 8 AI ±20 mA (4-20 mA)  (Option V318)  

16 AI ±20 mA (4-20 mA)  (Option V463)  
8 AI ±5 V (0-5 V, 1-5 V)  (Option V742)  
16 AI ±5 V (0-5 V, 1-5 V)  (Option V743)  

Input configuration Isolated (floating) analog inputs 
A to D Resolution 16 bit (including sign) 
Input Accuracy ±0.1% full scale @ -40ºC to +70ºC  
Input sampling time 10 mSec @ 50 Hz filtering  

8.33 mSec @ 60 Hz filtering   

Smoothing Selectable input averaging: 2,4,8, 16, 320, 64 or 128 samples  
Permitted Potential Between Inputs 75 V DC, 60 V AC (RMS)  
Input Impedance ±20 mA input: Rin < 250 Ω 

±5 V input: Rin > 1 MΩ 

Crosstalk Rejection Better than 80 dB between any pair of inputs  
Temperature Stability 25 PPM/ºC 
Interference suppression Selectable 50 or 60 Hz filtering,  

Common mode rejection > 80 dB, 
Differential mode rejection > 50 dB 

24 V DC output Supports optional isolated 24V /0.35 A plug-in Power Supply  
(one in 16 DI, two in 32 DI)  

Diagnostics LEDs Overflow and Underflow LED per each input status,  
Module error LED  
The module Overflow and Underflow levels can be configured to: 
Current inputs: ±20mA / 4-20 mA 
Voltage inputs: ±5 V / 0-5 V /1-5 V 

User Connection 2 or 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  
Cable and TB Holder 20 or 40 Wire Cable with TB Holder connector, 26 AWG  
Module Replacement Hot swap replacement– module extraction/insertion under voltage 
Input Isolation  1.5 kV between input and module logic  
Input Insulation Insulation resistance 100 MΩ @ 500 V DC, per IEC255-5 
Operating voltage 10.5-15.5 V DC and 3.3 V DC (from the motherboard connector)  
Power consumption 8 AI  : 0.1 W Typical, 0.5 W Max.   (all LEDs on) 

16 AI: 0.1 W Typical, 0.3 W Max.   (all LEDs on) 
(Not including Plug-in 24 V Power Supply) 

Dimensions 37 mm W x 225 mm H x 180 mm D, (1.5" W x 8.7" H x 7.1" D)  
Weight 8 AI  : approx.032 Kg   (0.71 lb)  

16 AI: approx. 0.34 Kg (0.75 lb) 

Specifications subject to change without notice. 
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MIXED I/O MODULE 

General Description 
The ACE3600 Mixed I/O modules include a mixture of Digital Inputs, Relay Outputs and 
Analog Inputs on the same module. 

The available Mixed I/O modules are: 

• 16 Digital Inputs + 4 EE DO Relay Outputs + 4 Analog Inputs ( ±20 mA) 

• 16 Digital Inputs + 4 ML DO Relay Outputs + 4 Analog Inputs ( ±20 mA) 

Figure 10-1 provides a general view of the ACE3600 Mixed I/O module. 
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Figure 10-1  ACE3600 Mixed I/O Module – General View 
 

Another type of mixed I/O is found on the Digital Output/Digital Input (DO/DI) FET module.  
See the Digital Output/Digital Input (DO/DI) FET module chapter above for more information. 
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Figure 10-2 provides a detailed view of the Mixed I/O module front panel. 
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Figure 10-2  ACE3600 Mixed I/O Module – Front Panel 
 

The Digital Input (DIs) on the Mixed I/O modules are voltage (“wet”) inputs IEC 61131-2 
Type II compliant.  All DIs can function as fast counters.  All DIs are optically isolated.  

Each DI can be an event trigger (by interrupt) to a high priority fast process. A high priority 
fast process enables very fast activation of an output in response to an input trigger and logical 
conditions. This high priority fast process is independent of the I/O scan (refer to the STS 
Application Programmer manual). 

All four relay outputs are Single Pole Double Throw (SPDT) and are referred to as the “Form 
C” relays. The physical position of each relay is monitored by the module logic, by using a 
back indication signal which is connected to the relay’s second contact set.  Any contradiction 
between the required position and the back indication signal, is reported to the CPU and is 
available to the user application program.  

In some applications, it is necessary to inhibit relay output operation when attending the site 
for safety reasons. In all DO relay modules; it is possible to inhibit all relays per DO module. 
When a module is configured to enable relay inhibiting, the power to the relays is provided 
from the power supply via a dedicated power line (12V DO), controlled from the “12V DO” 
input (TB located on the power supply module panel). When the input’s terminals are shorted, 
the relays are operational. When the input’s terminals are open, the relays are inhibited (EE 
relays in the OFF (0) position and ML relays do not change state.) 

The user application program can monitor the relay inhibiting status and act accordingly. Also, 
when the module’s relays are inhibited, any mismatch between the relay position and the 
output logical state is ignored. 
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The Mixed I/O modules Analog-to-Digital conversion resolution is 16 Bit (including sign). 
Each input is fully isolated from the other inputs on the module and also optically isolated from 
the module internal circuits. The modules are fully calibrated. It is possible to test and re-
calibrate the module in the field. 

The measured values are digitally filtered to reduce the 50 or 60 Hz noise. The user can select 
the filtering frequency per module. 

The measured values can be smoothed by digital filtering. Smoothing is accomplished by 
calculating the running average values of a defined number of converted analog values 
(samples). The user can select the level of smoothing per module. The higher the smoothing 
level chosen, the more stable is the smoothed analog value and the longer it takes until the 
smoothed analog signal is applied after a step response.  

The user can select how the analog values are represented to the user application program, as 
unitless numeric values or as scaled values that represent certain Engineering Units (EGU).  

Each AI module can include an optional plug-in floating 24V DC power supply to power 
external devices.  

Each analog input has two Status LEDs:  

• UF - indicates Underflow when lit 

• OF - indicates Overflow when lit 

The Mixed I/O modules support an optional 24V DC floating plug-in power supply (for 
contact “wetting” or other purposes). 

For a description of I/O module construction, location, LEDs, TB holder, and other common 
I/O module features, see the I/O Modules chapter above. For details on Mixed I/O Module 
specific parameters and configuration, see the Mixed I/O Module Configuration section below. 

Mixed I/O Module Configuration 
For configuration of the DIs, refer to the DI Module chapter. 

For configuration of the DOs, refer to the DO/DI FET Module or DO Relay Module chapter. 

For configuration of the AIs, refer to the AI Module chapter. 

Sleep Mode 
Each Mixed I/O module can be switched by the user application program to Sleep Mode. In 
Sleep Mode, the module does not function and the power consumption is minimized. During 
Sleep mode the user application program will get the predefined values per each I/O. 
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Module Status and Diagnostics 
In the event of Mixed I/O Module failure, the ERR LED will be lit. This event is registered by 
the CPU in the Error Logger.  DI Module failure status is also visible to the user application 
program.  

The Mixed I/O module can be diagnosed and monitored using the STS Hardware Test utility.  

For Hardware Test of the DIs, refer to the DI Module chapter. 

For Hardware Test of the DOs, refer to the DO/DI FET Module or DO Relay Module chapter. 

For Hardware Test of the AIs, refer to the AI Module chapter.  
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Module Block Diagram 
Mixed I/O 
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Mixed I/O Module Specifications 
Total Number of Inputs / Outputs 16 Digital Inputs + 4 EE Relay Outputs + 4 Analog Inputs  

( ±20 mA) (Option V245) 
16 Digital Inputs + 4 ML Relay Outputs + 4 Analog Inputs  
( ±20 mA) (Option V453) 

I/O Arrangement 1 group of 16 DIs with shared common 
4 relay outputs  - Form C 
4 isolated analog inputs 

DI Counter Inputs All inputs can be configured as fast counter  

DI Frequency 0 - 1 KHz  

DI Fast Counter Frequency 0 - 5 KHz  

DI Max. DC Voltage Max. 40 V DC 

DI “ON” DC voltage range +11 to +30 V DC  

DI “OFF” DC voltage range -5 to +5 V DC 

DI Current 6-10 mA  

Fast Capture Resolution 1 mS (Interrupt upon change of state)  

Event Time Tagging Resolution 1 mS (Interrupt upon change of state) 

DI Filtering 0 to 255 mSec (DC, programmable in 1 mSec steps) 

DI Counter Filtering 0 to 6.375 mSec  (programmable in 0.025 mSec steps for inputs 
configured as high speed counter)  

DO Contact Voltage Ratings Max. 60 V DC or 30 V AC RMS (42.4 V peak).  

DO Contact Power Ratings 2A @ 30 V DC, 0.6A @ 60V DC or 0.6A @ 30V AC  
(resistive load) 

DO Relay Back Indication Contact position - hardware back indication 

DO Fail State Configurable relay state on CPU fail: On, Off or ‘last value’  

AI Resolution 16 Bit (including sign) 

AI Accuracy ±0.1% full scale @ -40ºC to +70ºC  

AI Sampling time 10 mSec @ 50 Hz filtering  
8.33 mSec @ 60 Hz filtering 

AI Smoothing Selectable input averaging: 2,0,8, 16, 30, 60 or 128 samples  

AI max. Potential between AIs 75 V DC, 60 V AC (RMS)  

AI Impedance Rin < 250 Ω  

AI Crosstalk Rejection Better than 80 dB between any pair of inputs  

AI Temperature Stability 25 PPM/ºC 

AI Interference Suppression Selectable 50 or 60 Hz filtering, common mode rejection > 80 
dB, differential mode rejection > 50 dB 
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Diagnostics LEDs LED per each DO and DI. 
Overflow and Underflow LED per each AI. 

AI Overflow and Underflow levels can be configured to: 
            Current inputs: ±20mA / 4-20 mA 
            Voltage inputs: ±5 V / 0-5 V /1-5 V 

24 V DC output Supports one isolated 24V / 0.35 A plug-in “wetting” power 
supply  

User Connection 4 Terminal Blocks (3.5mm pitch), Maximum 18 AWG  

Cable and TB Holder 40 wire cable  with Terminal Block Holder connector, 26 AWG  

Module replacement Hot swap replacement– module extraction/insertion under 
voltage  

Input / Output Isolation  DI:  2.5 kV DC/AC between input and module logic  
            per IEC255-5 
DO: Between open contacts: 1kV, between contact and coil:  
            1.5 kV, between contact sets: 1.5 kV 
AI:  1.5 kV between input and module logic  

Input Insulation Insulation resistance 100 MΩ @ 500 V DC per IEC255-5 

Operating Voltage 10.5-15.5 V DC and 3.3 V DC (from the motherboard 
connector)  

Power Consumption 0.1 W Typical,  
EE: 1.3 W max. (all relays and LEDs on),  
ML: 0.8 W max. (all LEDs on)  
(not including Plug-in 24 V Power Supply) 

Dimensions 37 mm W x 225 mm H  x 180 mm D        
(1.5" W x 8.7" H x  7.1" D) 

Weight Approx. 0.31 Kg  (0.68 lb) 
 

Specifications subject to change without notice. 
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RADIO TYPES AND INSTALLATION KITS 

ACE3600 Radio Types 

 

In order to prevent overheating of the radio and and degradation of radio 
performance, the radio should not exceed operating duty factors of 30% 
transmission and 70% receive mode. 

The ACE3600 RTU supports conventional, analog trunked radios and digital trunked radios.  It 
also supports data radios and various wireless modems.  Conventional and analog trunked 
radios are connected to a plug-in radio modem port.  Digital trunked radios and wireless 
modems are connected to an RS232 port.   For information on configuring CPU ports for 
various radios/modems, see the ACE3600 STS User Guide.  For information on IP 
communications over such modems, see the ACE3600 STS Advanced Features manual. 

The following conventional/trunked mobile analog and digital radios and conventional portable 
analog and digital radios can be used with the ACE3600 RTU:  

 Analog Motorola Radios Digital Motorola Radios 

Trunked XTL5000 (analog trunking mode) XTL5000 (digital mode) 

CM200/CM140/EM200/GM3188  

GP320/GP328/HT750/PRO5150  

Conventional 

CDM750  
 
For complete radio specifications such as modulations, standards, Tx power output, Rx 
sensitivity, supply voltage, and power consumption, see the specific radio owner’s manual.   

The following table lists all the ACE3600 models that include radios. 

Conventional VHF Radio ACE3600Model 

ACE3600 for CM200/CM140/EM200/GM3188 VHF F7573A 

ACE3600 with CDM750 136-174 MHz F7563A 

ACE3600 for HT750/GP320/GP328 /PRO5150 VHF F7553A 

Conventional UHF Radio  

ACE3600 for CM200/CM140/EM200/GM3188 UHF F7574A 

ACE3600 with CDM750 403-512 MHz F7564A 

ACE3600 for HT750/GP320/GP328 /PRO5150 UHF F7554A 
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Trunked VHF Radio  

ACE3600 with XTL5000 136-174 MHz Analog F7523A 

ACE3600 with XTL5000 136-174 MHz Digital F7513A 

Trunked UHF Radio  

ACE3600 with XTL5000 380-520 MHz Analog F7524A 

ACE3600 with XTL5000 380-520 MHz Digital F7514A 

Trunked 800MHz Radio  

ACE3600 with XTL5000 800MHz Analog F7585A 

ACE3600 with XTL5000 800MHz Digital F7586A 
 
For a list of the radio models and regional options for the CM/EM/GM radios, see CM/EM/GM 
Radio Models and Regional Options for ACE3600 below. For a list of the radio models and 
regional options for the GP/HT/PRO radios, see GP/HT/PRO Radio Models and Regional 
Options for ACE3600 below. 

The radios in the models listed in the table above are installed on the RTU using the 
installation radio kits described below. 

Radio Installation Kits 
The following radio installation kits enable the user to install a radio in the ACE3600 RTU. 

     Option/Kit  

CDM750 V143AH/ 
FLN3638A 

NA EMEA APAC LA  

Conventional 
Mobile Radios 

CM200 CM140 GM3188 EM200 V148AC/ 
FLN3635A 

NA EMEA APAC LA  Conventional 
Portable Radios 

HT750 GP320 GP328 PRO5150 V154AE/ 
FLN3637A 

      

Analog Trunking 
Mobile Radios 

XTL5000 V157AB/ 
FLN3640A 

Digital Trunking 
Mobile Radios 

XTL5000 V681AT/ 
FLN3649A 

For instructions on mounting the radio on the ACE3600 frame, see the desired installation 
instructions below. 

For general instructions on mounting a radio on the wall, see Mounting the ACE3600 Radios 
on a Wall below. 
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XTL5000 Radio Installation Kit 
The XTL5000 radio installation kit (ACE3600 option V681AT or V157AB) enables the user to 
install the XTL5000 radio in ACE3600 Remote Terminal Units (RTU).  The ACE3600 can use 
the XTL5000 in two operation modes, depending on the system used. 

• Digital mode (ACE3600 option V681AT) - suitable for Astro 6.x system trunked 
ASTRO IV&D only  

• Analog mode (ACE3600 option V157AB) - suitable for SmartNet 3.x system or Astro 
4.x system (on the analog part only) 

The following hardware and firmware are required: 

• Radio firmware version 6.3E and above for digital trunked ASTRO IV&D.  (For 6.3E, 
HOST R04.51.01 DSP R04.50.00; for 6.5 HOST R05.00.00 and DSP R05.00.00)  

• Radio firmware version 6.5E and above for analog trunked system (DSP version 
R06.00.00 for radio firmware  R06.01.00)   

• ASTRO Infrastructure version SR6.3 and above for trunked ASTRO IV&D 

• Smartnet version 3.x or Astro version 4.x for analog trunked system 

• ACE3600 firmware 1.00 and above  

• ACE3600 System Tools Suite (STS) version 1.00 and above 

The FLN3649A/FLN3640A installation kits include a bracket, cables, and screws. 

IMPORTANT: The XTL5000 radio control head must be radio option W4 for revolving power 
button control head. 

 

Installation 
The XTL5000 radio can be mounted on the ACE3600 RTU using the metal bracket and cables 
as follows: 

Procedure 11-1 How to Install the XTL5000 Radio on the Metal Chassis 

1. Attach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
on the ACE3600 CPU module.  For instructions on attaching plug-in ports, see 
Connecting Plug-In Ports to the CPU Module in the CPU Module chapter above. 

2. Attach the XTL5000 radio to the metal bracket (#0789422V41 from FHN6895A) using 
the four supplied radio screws (#0310906A67), two on each side.  (See Figure 11-1.)  
The wider side of the bracket should be on the right side of the radio (closer to the 
knobs.) 

3. Connect the 26-pin connector of the signal cable (FKN8432A for digital mode or 
FKN8438A for analog mode) to the Accessory connector on the radio.  Connect the 
opposite side of the signal cable to the port on the CPU module.  (See Figure 11-2 and 
Figure 11-4.)  For digital mode use any of the serial on-board or plug-in ports.  For 
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analog mode only the plug-in ports may be used.    See RTU Port Configuration for the 
Astro IV&D Digital Radio and RTU Port Configuration for the Astro IV&D Analog 
Trunked Radio below. 

4. Connect the DC power cable (FKN8436A) to the Power connector on the radio and the 
free red wire to the ignition pin on the FKN8432A/FKN8438A cable.  Connect the 
opposite side of the power cable to the AUX2A or AUX2B connector on the ACE3600 
power supply unit.  (See Figure 11-2 and Figure 11-4.) 

 

 

               

 

Figure 11-1  XTL5000 Radio and Metal Bracket 
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Figure 11-2 XTL5000 Radio Cable Connections- Rear View 
 

5. Mount the bracket on the RTU chassis above the CPU and I/O modules, using the four 
built-in screws.  (See Figure 11-4.)  The wider side of the bracket is attached to the 
chassis. 

6. Connect the antenna cable (FKN8437A) to the Antenna connector on the XTL5000.  Run 
the cable through the small white clips along the edge of the chassis and attach the 
connector to the opening on the bottom of the ACE3600 RTU housing.  (See Figure 11-2 
and Figure 11-4.) 

  

 

Figure 11-3  XTL5000 Radio Bracket with Four Bracket Mounting Screws 
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Figure 11-4 XTL5000 Radio Insta
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Port Type (for Astro IV&D Digital Radio) 
Procedure 11-2 How to Configure the ACE3600 Port for the Astro IV&D Digital Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the on-board or plug-in port through which the RTU will 
communicate with the XTL5000 radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below. 

4. Define desired links. 

5. If you plan to synchronize the RTU time from the Front End Processor (FEP) in the 
Customer Enterprise Network (CEN), specify the IP address of the FEP in the NTP field.  
This IP address information is provided by your ASTRO IV&D system operator.  

6. Save the changes. 

 

Figure 11-5  RTU Site Configuration for MDLC over ASTRO IV&D – Port Type Parameters 
 

Advanced Parameter Configuration (for Astro IV&D Digital Radio) 

 

Figure 11-6  RTU Site Configuration for MDLC over ASTRO IV&D – Advanced Parameters 
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Generally no other changes are required to Advanced Physical or Link Layer parameters.  For 
information on these parameters, see the MDLC over IP chapter of the ACE3600 STS 
Advanced Features manual. 

Procedure 11-3 How to Configure the Advanced Parameters of the ACE3600 Port for the Astro 
IV&D Digital Radio 

1.  (ASTRO System 6.3-6.5 only) Make sure that the Advanced Link parameter 
Registration life time to 28800 seconds (default) in order to restart the radio periodically.   

2. If any changes are required, click on the appropriate screen in the Port Tab.   

3. Change the settings as necessary.  
Note:  The Default Group ID Address should be left 000.000.000.  The actual values will 
be read by the RTU from the radio upon connection.  

4. Save any changes. 

5. Save the project. 

6. Download the site configuration to the ACE3600 RTU. 

IP Conversion Table (for Astro IV&D Digital Radio) 
Prepare an IP conversion table if the RTU must communicate with another RTU or an IP 
Gateway.  In the IP conversion table, specify the IP address of each RTU port (site ID + link 
ID).  This IP address is assigned by the infrastructure operator. 

Note that an IP address is obtained from the radio once it is connected to the RTU port over 
PPP. The IP address obtained from the radio is not the real IP address set by the infrastructure, 
but rather a dummy address.  This dummy is configured in the radio via the CPS Mobile 
Computer IP address parameter (by default 192.168.128.2).   

When device LINxL level 0 is retrieved using the ACE3600 STS Software Diagnostics tool, 
the IP Address displayed is this dummy address and not the actual IP address assigned by the 
infrastructure operator.   

It is recommended to create two IP conversion tables:  

1. The first is downloaded to the FIU or IP Gateway on the LAN and includes the site and 
IP information for each RTU. 

2. The second is downloaded to all RTUs which are connected to the infrastructure with 
ASTRO IV&D radios, and includes the site and IP information for the FIU and IP 
Gateway. 

For detailed instructions on preparing the IP conversion table, refer to the IP Communications 
chapter of the ACE3600 STS Advanced Features manual. 

Radio Programming using CPS for the Astro IV&D Digital 
The XTL5000 radio is programmed for ACE3600 in the factory and is ready for ASTRO 
IV&D communication.  For user programming of site-specific parameters, the radio should be 
brought to the Motorola Service Center.   
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Radio Connections 
To program the XTL5000 radio with Customer Programming Software (CPS), the radio must 
be connected to a PC.   

Procedure 11-4 How to Connect the XTL5000 Radio to the CPS 

1. Connect one side of the programming cable (HKN6155) to the microphone connector on 
the front of the radio.  This cable is not supplied and must be ordered separately. 

2. Connect the other side to the serial port of a PC on which the ASTRO CPS software 
(RVN4185) is installed. 

Radio Disassembly 
If the XTL5000 radio is to be programmed outside of the ACE3600 housing, disassemble the 
radio as follows:  

Procedure 11-5 How to Disassemble the XTL5000 Radio from the ACE3600 Metal Chassis 

1. Disconnect the antenna cable (FKN8437A) to the Antenna connector on the radio. 

2. Remove the radio/bracket unit from the RTU chassis by unscrewing the four built-in 
screws. 

3. Disconnect the DC power cable (FKN8436A) from the Power connector on the radio. 

4. Disconnect the 26-pin connector of the signal cable (FKN8432A/FKN8438A) from the 
Accessory connector on the radio. 

5. Detach the metal bracket (#0789422V41 from FHN6895A) by unscrewing the four radio 
screws (#0310906A67), two on each side. (See Figure 11-1.) 

6. Take the radio to a laboratory for programming, as described in CPS Programming 
Settings below. 

CPS Programming Settings 
Before programming the radio, read the codeplug file from the radio and save it to your PC 
using the File >Read Device command in the CPS (R04.01.01 for radio firmware 6.3E; 
R05.00.00 for firmware 6.5).  Open the codeplug file in the CPS and set the parameters as 
follows. 

Procedure 11-6 How to Program the XTL5000 Digital Radio 

1. In the CPS, click on the codeplug in the tree view to view and select the items below or 
select them from the Feature menu. 

2. Under Radio Configuration, double-click on Radio Wide.  

a. In the Transmit Power Levels tab, reduce the radio power level to low: Change 
TX Power Level Low for Freq. Range A from 16.5 to 10. (Range A 700Mhz 
UHF and VHF). 

1) Change TX Power Level Low for Freq. Range B from 19.0 to 10. (Range B 
800Mhz and UHFR2 (470-520Mhz). 

2) Change TX Power Level High for Freq. Range A from 33.0 to 15. 



Radio Types and Installation Kits 

11-10 

3) Change TX Power Level High for Freq. Range B from 38.5 to 15. 

b. In the General tab, set the Out of Range Indicator and Imbalanced Coverage 
Indicator to Alert & Display. 

c. (Recommended) In the Data tab, enable SNMP Traps.  (You can disable it, but 
the RTU will only detect a loss of context activation the next time it polls the 
radio (every 10 seconds by default). 

d. (Optional) Specify the Mobile Computer IP address. This is the dummy IP 
address assigned to the RTU by the radio (by default it is 192.168.128.2).  For 
each radio, it is recommended to change the last digit in the Mobile Computer IP 
address (e.g. to the Unit ID in Trunking systems.)  

e. (CPS R05.00.00 only) In the Advanced tab, make sure that "MOSCAD Data 
Enable" is not enabled (not checked.)  (For IV&D only.  For communication over 
analog ASTRO Trunking, leave it enabled.) 

3. Double-click on NAT List -> NAT List Entry 1. 

a. Add an entry to the NAT List: 

1) WAN port =  MDLC over IP port number (e.g. 2002) 

2) LAN port = MDLC over IP port number (e.g. 2002) 

3) Static NAT IP Address = Mobile Computer IP Address (e.g. 192.168.128.2).  

4) The Mobile Computer address should match the Mobile Computer IP Address 
assigned on the Radio Configuration>Radio Wide>Data tab in Step 2 above. 

4. Double-click on Trunking ->Trunking System ->Trunking System 1. 

a. In the General tab, set the Type to ASTRO 25.  If the proper system key was 
loaded, the System Key field should already be enabled. 

b. Set the ASTRO 25 Home System ID, Home WACN ID and Unit ID to values 
obtained from the radio system administrator.  

c. Under Coverage Type, set the type to SmartZone. 

d. In the Astro 25 Channel ID tab, enable the first channel. 

e. In the 700/800 Astro 25 Control Channels tab (700_800 or OBT depending on 
the band), enter the control channels with which the data subscriber should be 
able to affiliate. Consult your radio system administrator for the list of control 
channels.  

f. In the Data tab, enable Packet Data Capable System (PDS), and Terminal Data 
and disable (uncheck) Rx Voice Interrupts Data. 

5. Double-click on Trunking ->Trunking Personality ->Trunking Personality 1. 

a. In the General tab, set the Protocol Type to ASTRO 25 and set the System & ID 
to 1. 
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b. In the 700/800 Failsoft tab, data only subscribers should set Failsoft Type to 
disabled.  (There is no data service unless the subscriber is affiliated to a wide-
area trunking site.) 

c. In the Talkgroup tab, set the radio talkgroup value in hexadecimal.  Consult your 
radio system administrator for the talkgroup information. 

d. (Recommended) In the Preferred Sites tab, set the status of the first record to 
None.  (This means that data only subscribers are not locked into preferred sites.) 

6. Double-click on Zone Channel Assignment ->Zone Channel Assignment. 

a. In the Zone tab, set the Zone to the desired zone name (e.g. ZONE1). 

b. In the Channels tab, set the Channel to the name which will be displayed on the 
radio screen (if the radio is Model II or III).  

c. Select the Personality type of that channel.  

d. Specify the Personality # of that channel. 

e. Specify the Talkgroup # of that channel. 

7. From the Tools menu, select the Change Control Head command.  Make sure the Control 
Head Type is set to W4 and click OK.  

8. From the File Menu, select Save to save changes to the radio. 

9. From the File Menu, select Write Device to download the configuration to the radio. 

Infrastructure Configuration for the Astro IV&D Digital Radio 
In order for the ACE3600 RTU to communicate over the ASTRO IV&D infrastructure (6.4 or 
later) using the XTL5000 digital radio, the infrastructure must be properly configured using the 
UCM (User Configuration Manager) tool.  

Note: If configuring a border router or any firewall within the CEN (Customer Enterprise 
network), make sure that the ACE3600’s MDLC over IP UDP port number 2002 is enabled for 
inbound and outbound messages. 

Note: In the UCM Radio User Data Settings tab, be sure to set the IP address as Static, to 
enable Generate ICMP and Source Address Checking, and the Ready timer set to 10 seconds.  

 

RTU Port Configuration for the Astro IV&D Analog Trunked Radio 
To enable MDLC communication using Astro XTL5000 radios, use the ACE3600 STS site 
configuration utility to configure the ACE3600 RTU port (either on-board serial or plug-in 
port) connected to the radio.  For more information, refer to the IP Communications chapter of 
the ACE3600 STS Advanced Features manual.    

Port Type (for Analog Trunked Radio) 
Procedure 11-7 How to Configure the ACE3600 Port for the Astro IV&D Analog Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.     
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2. In the Port Tab, click on the plug-in port through which the RTU will communicate with 
the XTL5000 radio.   

3. Set the port parameters as shown in the screen below.  The Trunk system parameter 
should reflect the type of trunking system (e.g. SmartNet, SmartZone.) 

4. Save the changes. 

 

Figure 11-7  RTU Site Configuration for MDLC over Analog Trunked System – Port Type 
Parameters 

 

Programming the XTL5000 Analog Trunked Radio using CPS 
The XTL5000 radio is programmed for ACE3600 in the factory and is ready for analog 
trunked communication.  For user programming of site-specific parameters, the radio should be 
brought to the Motorola Service Center.   

Radio Connections 
Follow the Radio Connections instructions described under Radio Programming using CPS for 
the Astro IV&D Digital above.  

Radio Disassembly 
Follow the Radio Disassembly instructions described under Radio Programming using CPS for 
the Astro IV&D Digital above.   

CPS Programming Settings 
Before programming the radio, read the codeplug file from the radio and save it to your PC 
using the File >Read Device command in the CPS (DSP version R06.00.00 for radio firmware 
R06.01.00.)  Open the codeplug file in the CPS and set the parameters as follows. 

Procedure 11-8 How to Program the XTL5000 Analog Radio 

1. In the CPS, click on the codeplug in the tree view to view and select the items below or 
select them from the Feature menu. 

2. Under Radio Configuration, double-click on Radio Wide.  

a. In the Transmit Power Levels tab, reduce the radio power level to low: Change 
TX Power Level Low for Freq. Range A from 28.0 to 10.  

1) Change TX Power Level High for Freq. Range A from 53.5 to 15.  

b. In the Advanced tab, make sure that "MOSCAD Data Enable" is enabled.   

c. In the Time Out Timer tab, make sure the Time # is set to 3 (for 60 sec).  

3. Double-click on Controls. 
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a. Click on Control Head. 

b. Make sure that the control head is W4. 

c. Click on Radio VIP.   

1) Set VIP In for VIP 1, VIP 2, and VIP 3 to Blank. 

2) Set VIP Out for VIP 1 to MOSCAD CG. 

3) Set VIP Out for VIP 2 to MOSCAD TXE/CM. 

4) Set VIP Out for VIP 3 to NULL. 

4. Double-click on Conventional ->Conventional Personality -> Conventional Personality 1. 

a. In the Rx Options tab, set Unmute/Mute Type to UnMute, Or Mute. 

b. Set Rx Voice/Signal Type to Non-Astro. 

c. Enable (check) Rx Emphasis and Busy LED. 

d. In the Tx Options tab, make sure that the Time Out Timer is set to 3 (for 60 sec). 

e. Set Tx Voice/Signal Type to Non-Astro. 

f. Set Transmit Power Level to High. 

5. Double-click on Trunking ->Trunking System ->Trunking System 1. 

a. In the General tab, if the proper system key was loaded, the System Key field 
should already be enabled. 

b. Set the Type to II. 

c. Set the Type II System ID, and Connect Tone to values obtained from the radio 
system administrator for the site. 

d. Under Coverage Type, set the type to Disabled. 

e. In the Type II tab, set the Individual ID to the value obtained from the radio 
system administrator for the site. 

f. Set the Affiliation type to Automatic. 

g. In the Channel Assignment tab, enter the Rx and Tx channel ranges. Consult 
your radio system administrator for the list of values. 

h. In the OBT Control Channels tab, set the RX Frequency and TX Frequency of 
each control channel with which the data subscriber should be able to affiliate. 
Consult your radio system administrator for the list of control channels. 

6. Double-click on Trunking ->Trunking Personality ->Trunking Personality 1. 

a. In the General tab, set the Protocol Type to II and set the System ID to the value 
obtained from the radio system administrator for the site.  Make sure that the 
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Time Out Timer is set to 3 (for 60 sec).  Check that the Type II Individual ID is 
set to the value obtained from the radio system administrator for the site. 

b. In the Talkgroup tab, set the radio talkgroup value in hexadecimal.  Consult your 
radio system administrator for the talkgroup information.  (Note: Talkgroup for 
voice in analog trunking is the same for voice and data on analog trunk. 

7. From the File Menu, select Save to save changes to the radio. 

8. From the File Menu, select Write Device to download the configuration to the radio. 

XTL5000 Radio Models and Options for ACE3600 
The XTL5000 radio installation kit is used with one of the following XTL5000 radio:  

Description Nomenclature Band 

XTL5000 Mobile 10-35 W, 764-870MH M20URS9PW1 N 764 - 870 MHz 

XTL5000 UHF R1 Mobile 10-40 W 380-470 M20QSS9PW1 N 380 - 470Mhz 

XTL5000 UHF R2 450-520 MHZ 10-45 W M20SSS9PW1 N 450 - 520Mhz 

XTL5000 VHF Mobile 10-50 W 136-174 MHZ M20KSS9PW1 N 136 - 174Mhz 
 

All of the following options may be ordered with the XTL5000 radio:  

Option Name Option Number 

ADD: W4 CONTROL HEAD G73 

ADD: NO MICROPHONE NEEDED G90 

ENH: SOFTWARE ASTRO DIGITAL CAI OPERATION G806 

ENH: ASTRO PROJECT 25 TRUNKING SOFTWARE G361 

ADD: CONTROL HEAD SOFTWARE, W4 G93 

ENH: SMARTZONE OPERATION G51 

ENH: RS232 PACKET DATA INTERFACE W947 

ADD: DASH MOUNT G66 

ADD: NO SPEAKER G142 

ADD: NO ANTENNA G89 
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CDM750 Radio Installation Kit 
The CDM750 radio installation kit (ACE3600 option V143AH/kit FLN3638A) enables the 
user to install the CDM750 radio series in ACE3600 Remote Terminal Units (RTU).  The 
FLN3638A installation kit includes a bracket, adapter, and cables. 

Installation 
The CDM750 radio can be mounted on the ACE3600 RTU as follows: 

Procedure 11-9 How to Install the CDM750 Radio on the Metal Chassis 

1. Attach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
on the ACE3600 CPU module.  For instructions on attaching plug-in ports, see 
Connecting Plug-In Ports to the CPU Module in the CPU Module chapter above. 

2. Connect the radio adapter (FLN3639A) 16-pin connector to the radio Accessory 
connector (See Figure 11-8.) 

3. Connect the power cable (FKN8436A) to the radio power connector, and the opposite 
side of the cable to the AUX2A or AUX2B connector on the ACE3600 power supply 
module. 

4. Connect the communication cable (FKN8427A) to the rear connector (8-pin RJ45 
connector) of FLN3639A.  Connect the opposite side of the cable to the plug-in port on 
the CPU module. 

 

 

 

 

 

Figure 11-8  CDM750 Antenna, Power and Communication Cable Connections 
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4. Connect the antenna cable (FKN8437A) to the Antenna connector on the radio and to the 
opening on the bottom of the ACE3600 RTU housing, using the four supplied screws. 
See Figure 11-8 and Figure 11-10.) 

5. Attach the radio to the bracket (0789422V45 from FHN6898A) by using screws and 
washers from kit FHN6898A. See Figure 11-9 below. 

 

 

Figure 11-9  CDM750 Radio and Metal Bracket 
 

6. Attach the complex (radio + bracket) using the four supplied screws to the ACE3600 
chassis.  See Figure 11-10 below. 
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Figure 11-10  CDM750 Radio Installed on ACE3600 C
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RTU Port Configuration for the CDM750 Radio 
To enable MDLC communication using CDM750 radios, use the ACE3600 STS site 
configuration utility to configure the ACE3600 RTU plug-in port connected to the radio.     

The following figures show the port configuration and advanced parameter configuration.  
Although these show Port PI1, the same values can be applied to port PI2 as well, where 
relevant.  

Port Type 
Procedure 11-10 How to Configure the ACE3600 Port for the CDM750 Radio 

1. In the ACE3600 STS click on the desired site, and open the site view.   

2. In the Port Tab, click on the plug-in port through which the RTU will communicate with 
the radio.   

3. Confirm that the port parameters and data speed are as shown in the screen below. 

4. Define desired radio links and zones if necessary. 

5. Save the changes.  Generally no other changes are required to Advanced Physical or Link 
Layer parameters. 

 

Figure 11-11  RTU Site Configuration for MDLC over CDM750 Radio – Port Type Parameters 
 

Programming the CDM750 Radio using CPS 
The CDM750 radio is programmed for ACE3600 in the factory and is ready for 
communication.  For user programming of site-specific parameters, follow the instructions 
below.   

Radio Connections 
To program the CDM750 radio with Customer Programming Software (CPS), the radio is 
connected to a PC using the standard Radio Interface Box (RIB).   

Procedure 11-11 How to Connect the CDM750 Radio to the CPS 

1. Connect one side of the programming cable (PMKN4004) to the radio Accessory 
connector and the other side to the 25-pin connector on the RIB (RLN4008).  The RIB 
and cable are not supplied and must be ordered separately. 

2. Using the 9-pin interface cable (3080369B72), connect the RIB to the serial port of a PC 
on which the CDM750 CPS software (HVN9025) is installed. 

3. Connect the RIB to a power RIB power supply or 9V battery. 
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Radio Disassembly 
If the CDM750 radio is to be programmed outside of the ACE3600 housing, disassemble the 
radio as follows:  

Procedure 11-12 How to Disassemble the CDM750 Radio from the ACE3600 Metal Chassis 

1. Disconnect the antenna cable (FKN8437A) to the radio Antenna connector. 

2. Remove the radio/bracket unit from the RTU chassis by unscrewing the four built-in 
screws. 

3. Disconnect the DC power cable (FKN8436A) from the radio Power connector. 

4. Disconnect the radio adapter (FLN3639A) 16-pin connector from the radio Accessory 
connector. 

5. Detach the metal bracket (FHN6898A) by unscrewing the two radio screws 
(#0387839V89), one on each side. (See Figure 11-9.) 

CPS Programming Settings 
The following programming instructions must be performed before connecting a CDM750 
radio to the ACE3600 family Remote Terminal Units (RTU). These instructions define 
miscellaneous settings and the function of each pin in the radio’s general purpose I/O 
connector.  

Procedure 11-13 How to Program the CDM750 Radio 

1. Before programming the radio, read the codeplug file from the radio and save it to your 
PC using the File >Read Device command in the CPS.   

2. Open the codeplug file in the CPS.  Click on the codeplug in the tree view to view and 
select the items below or select them from the Feature menu. 

3. Under Radio Configuration, change the settings on the Basic, Tx Power, Accessory 
Configuration, and Accessory Pins tabs, as shown in the screens below.   

4. Under Controls and Menus->Conventional Buttons, change the settings to the Mobile 
Key Buttons and Programmable Buttons tabs, as shown in the screens below. 

5. Under Conventional Personality 1, change the settings to the Basic, Options and 
Advanced tabs, as shown in the screens below. 

6. Under Personality Assignment to Zone 1, make sure that the desired channel(s) appear on 
the list on the Channels tab.  If not all the assigned channels are required, remove them 
from the assignment list.  

7. From the File Menu, select Save to save changes to the radio. 

8. From the File Menu, select Write Device to download the configuration to the radio. 
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Figure 11-12 Radio Configuration- Basic Settings 

 

Figure 11-16 Radio Configuration- Tx Power 
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Figure 11-13 Radio Configuration - Accessory Connector Configuration 

 

Figure 11-14 Radio Configuration - Accessory Pins Definition 
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Figure 11-15 Conventional Buttons Configuration – Mobile Key Buttons 

  

Figure 11-16 Conventional Buttons Configuration – Programmable Buttons 
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Figure 11-17 Conventional Personality Configuration – Basic Settings 

 

Figure 11-18 Conventional Personality Configuration – Options 
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Figure 11-19 Conventional Personality Configuration – Advanced Settings 

 

Figure 11-20 Radio Channel Assignment - Personality Assignment to Zone 
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GP/HT/PRO Radio Installation Kit 
The GP/HT/PRO Radio Installation Kit for ACE3600 (V154AE, FLN3637A) enables the user 
to install the GP320/GP328/HT750/PRO5150 portable radios in ACE3600 Remote Terminal 
Units (RTU). Each kit includes a bracket, radio interface, adapters, and cables. 

Volume Knob Retainer 
The volume knob retainer sets a fixed position for the volume knob on the GP/HT/PRO radios, 
for optimal operation in an ACE3600 RTU installation. To implement this option, follow the 
procedure below. 

Procedure 11-14 How to Attach the Volume Knob Retainer for the GP/HT/PRO Radio 

1. Remove the original plastic volume knob cover from the radio by pulling it out with 
pliers, as shown in Figure 11-21. 

Figure 1
 

2. Place the hole of the vo
metal volume rod on the

Figure
 

3. Fasten the bottom of the
Volume Knob 
11-25 

 

1-21 Removing the Volume Knob 

lume knob retainer (shown in Figure 11-22) over the exposed 
 radio (shown in Figure 11-23.) 

 

 11-22 Volume Knob Retainer 

 volume knob retainer to the radio body. (See Figure 11-23.) 
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Figure 11-23 Attach Retainer to Radio 

P/HT/PRO radio can be mounted on the ACE3600 RTU as follows: 

ttach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
n the ACE3600 CPU module.  For instructions on attaching plug-in ports, see Connecting 
lug-In Ports to the CPU Module in the CPU Module chapter above. 

onnect the audio accessory adapter (HLN9716C) (Item 1) to the radio.  See Figure 11-24. 

nsert the communication cable (FKN8431A) (Item 2) into the audio accessory adapter. 

nsert the BNC antenna adapter (FTN6045B) into the radio antenna connector (Item 3). 

nap the radio into the DC adapter (FCN5516B) (Item 4). 

nsert the DC power cable (FKN8433A) into the DC connector of the DC adapter (Item 5). 

Retainer 
(Motorola P/N 
0787502V66) 
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Figure 11-24 GP/HT/PRO Radio Installation 
 

7. Using the two screws, attach the radio assembly to the radio bracket (FHN6899A). 

8. Using the three screws on the bracket, attach the bracket with the radio to the chassis of the 
ACE3600. (See Figure 11-25.) 

9. Connect the audio communication cable (FKN8431A) from the audio adapter (attached to 
the radio) to the desired plug-in port on the front panel of the CPU module. 

10. Connect the DC power cable (FKN8433A) from the DC adapter (attached to the radio) to 
the AUX2A or AUX2B connector of the power supply module. 

11. Route the antenna cable (FKN8434A) from the bottom of the RTU box to the BNC adapter 
on the radio. 

12. Use the clamps provided in the kit to route and secure the audio communication and DC 
power cables. (See Figure 11-25.) 
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Figure 11-25 GP/HT/PRO Radio Installed on ACE3600 Chassi
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4. Define desired radio links and zones if necessary. 

5. Save the changes.  Generally no other changes are required to Advanced Physical or Link 
Layer parameters. 

 

Figure 11-26  RTU Site Configuration for MDLC over GP320/GP328/HT750/PRO5150 Radio –  
Port Type Parameters 

 

GP/HT/PRO Radio Models and Regional Options for ACE3600 
The GP/HT/PRO models of the ACE3600 RTU, F7553A (VHF) and F7554A (UHF) include 
the following regional options: 

Option Region Radio 
V951 North America (NA)  HT750 

V952 EMEA GP320 

V953 Asia GP328 

V954 Latin America (LA)  PRO5150 

V154AE     GP/HT/PRO INSTALL KIT  

FLN3637A GP/HT/PRO INSTALL KIT  

 

Note: 

1. When ordering ACE3600 model with a GP/HT/PRO radio, a V95x option must be added. 

2. For models/options availability, see the latest sales price list. 

3. Orders to EMEA should be placed as model without radio and radio as a kit 
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CM/EM/GM Radio Installation Kit 
The CM/EM/GM Installation Kit for ACE3600 (V148AC/FLN3635A) enables the user to 
install the CM/EM/GM mobile radio (CM200, CM140, EM200, GM3188) in ACE3600 
Remote Terminal Units (RTU).  Each kit includes a bracket, adapter, and cables. 

Installation 
The CM/EM/GM can be mounted on the ACE3600 RTU as follows: 

Procedure 11-16 How to Install the CM/EM/GM Radio on the Metal Chassis 

1. Attach the radio plug-in port from the installation kit (FLN3696A) to the desired opening 
on the ACE3600 CPU module.  For instructions on attaching plug-in ports, see Connecting 
Plug-In Ports to the CPU Module in the CPU Module chapter above.  

2. Connect the 16-pin connector radio adapter (FLN3636A) to the accessory connector on the 
radio. (See Figure 11-27.) 

 

Figure 11-27 CM/EM/GM Radio, Adapter and Power Cable 
 

3. Connect the power cable (FKN8428A) to the radio’s power connector. (See Figure 11-27 
and Figure 11-28.)  Connect the other side of the power cable to the AUX2A or AUX2B 
connector on the ACE3600 RTU Power Supply unit. (See Figure 11-29.)  
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Figure 11-28 CM/EM/GM Radio Cable Connections 
 

4. Connect the communication cable (FKN8427A) to the back of the radio adapter 
(FLN3636A) connector (10-pin RJ45 connector). (See Figure 11-28.) Add a Fair-Rite soft 
ferrite (#7683477X01) to the cable near the bottom of the CPU door, and connect the other 
end of the communication cable to the plug-in port of the ACE3600 CPU.  

5. Mount the CM/EM/GM radio onto the metal bracket (#0789422V45) using the two 
supplied radio mounting screws from kit FHN6894A, # 0387839V89 on the top and 
bottom of the radio. (See Figure 11-27, Figure 11-28 and Figure 11-29.) 

6. Connect the antenna cable (FKN8429A/FKN8430A*) to the antenna connector on the radio 
and to the opening on the bottom of the ACE3600 housing using the four supplied screws. 
(See Figure 11-28 and.)  Mount the complex (bracket and radio) on the RTU chassis above 
the CPU and I/O modules, using the four built-in screws. (See Figure 11-29.) 

                                                      
*  Antenna Cable FKN8429A with UHF connector is for Latin and North America. 
   Antenna Cable FKN8430A with BNC connector is for Asia and Europe. 
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Figure 11-29 CM/EM/GM Radio Installed on ACE3600 Chassi

 

RTU Port Configuration for the CM/EM/GM Radio 
To enable MDLC communication using CM/EM/GM radios, use the ACE
configuration utility to configure the ACE3600 RTU plug-in port connecte

Follow the instructions for RTU Port Configuration for the CDM750 Radi

Programming the CM/EM/GM Radio using CPS 
The following programming instructions must be performed before connec
radio to an ACE3600 RTU.  These steps define miscellaneous settings and
pin in the radio’s general purpose I/O connector.  
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Radio Information 
The picture below shows the radio model information screen in the CPS. 

 

Figure 11-30 CM/EM/GM CPS Radio Information Screen 
 

Radio Power Settings 
The picture below shows the TX power setting (1-25 W) in CPS. 

 

Figure 11-31 CM/EM/GM CPS General Settings Screen 
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Radio Accessory Connector Pins Definition 
The picture below shows the setting of the radio’s accessories pins required for interfacing with 
the ACE3600. 

 

Figure 11-32 CM/EM/GM CPS Radio Accessories Screen 
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Frequency and Bandwidth Settings 
The picture below shows the setting of the radio’s frequency, bandwidth and power level. 

 

Figure 11-33 CM/EM/GM CPS Radio Personality Tx/Rx Screen 
 

Note: The Power Level should be set according to the power output. 
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CM/EM/GM Radio Models and Regional Options for ACE3600 
The CM/EM/GM models of the ACE3600 RTU, F7573A (VHF) and F7574A (UHF) include 
the following regional options: 

Option Region Radio 
V851 North America (NA)  CM200, 1-25W 

V852 EMEA* CM140, 1-25W 

V853 Asia* GM3188, 1-25W 

V854 Latin America (LA)  EM200, 1-25W 

V148AC     CM/EM/GM INSTALL KIT  

FLN3635A CM/EM/GM INSTALL KIT  

 

Note: 

1. When ordering an ACE3600 model with a CM/EM/GM radio, a V95x option must be 
added. 

2. For models/options availability, see the latest sales price list. 

 

 

                                                      
*  Antenna Cable FKN8429A with UHF connector is for Latin and North America. 
   Antenna Cable FKN8430A with BNC connector is for Asia and Europe. 
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Mounting the ACE3600 Radios on a Wall 
ACE3600 radios can be mounted on a wall near the ACE3600 frame/housing, using a special 
metal bracket. 

80

75

P/N:0789422V45
REV:A

17
9.

8

223

  

145
80

7518
2.

5

P/N:0789422V41B

   

CM/EM/GM/CDM750 Bracket                           XTL5000 Bracket 
74

 

GP/HT/PRO Bracket  
Figure 11-34  Radio Wall Mount Brackets 

 
Procedure 11-17  How to Mount a Radio on a Wall 

The following installation procedure should be followed to install radios on a wall near the 
ACE36000 frame.  A special wall mount bracket is provided with the radio installation kit, 
which can be ordered separately from the frame.  Allow extra space around the bracket for the 
radio and wires. 

1) Drill four holes in the wall at the horizontal and vertical distances (in mm) shown in Figure 
11-34 for the desired radio wall mount bracket, at the desired angle/orientation. 

2) Place the bracket on the wall, lining up the bracket holes with the drilled holes. 
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3) Insert four M3 Phillips 10mm screws (not supplied) into the holes and tighten with a 
screwdriver to secure the bracket firmly against the wall. 

4) Attach the radio to the bracket using the supplied screws.  
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PLASTIC BOX INTERFACES 

Plastic Box Interfaces 
Cards such as RS485 interface card can be attached to the ACE3600 RTU using a plastic box.  
The plastic box can be attached to the 19" accessories metal chassis, small/large metal chassis, 
or small/large NEMA housing. 

Procedure 12-1 How to Install the Plastic Box Interface on the Metal Chassis 

1) To connect the plastic box interface to the metal plate, place the box on the metal plate and 
click into holes.  See Figure 12-1. 

Mobile Radio

Portable Radio
Plastic Boxes

Battery
 

Figure 12-1   Accessories Installed on a Metal Chassis 
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CONFIGURATION 

General 
For information on setting the 12V DO dipswitch in the DO relay module board, see the 
Digital Output Relay chapter above.  

 



14-1 

OPTIMIZATION 

General 
No optimization is required for the ACE3600 units. 
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OPERATION 

General 
The operational functions of the ACE3600 unit are performed using the ACE3600 System 
Tools Suite (STS).  These are administrative and diagnostic tasks, generally performed by 
technicians and administrators.  The functions available depend on the specific software 
applications installed in the unit. 

See the ACE3600 STS User Guide for details. 
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MAINTENANCE 

General 
The following maintenance procedures are recommended for the ACE3600 RTU. 

Lead Acid Battery Maintenance 
It is recommended to perform the following maintenance procedures for the lead acid battery 
using the ACE STS Hardware Test utility or the user application program: 

• Once per month - run a full battery test (battery capacity) of the lead acid battery. 

• Once per day - run the short battery test (charge level) of the lead acid battery. 

If the capacity is below the manufacturer recommended level, replace the battery.  See the 
Power Supply Module and Backup Battery chapter above. 
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TROUBLESHOOTING 
 

Symptom Action  
The PWR LED on the CPU module 
front panel is not lit. 

Check power connections to the unit.   
If all connections are correct, check cables. 

The Power LED on the CPU 
module front panel is red. 

The CPU has received an error from the power 
supply (AC fail, Bat Error etc.)  Check the AC power 
supply, backup battery, etc. 

The ERR LED on the CPU module 
front panel is red. 

The unit has a problem.  Check the Error Logger to 
read error message. 

The ERR LED on the CPU module 
front panel is orange. 

The unit has a warning.  Check the Error Logger to 
read warning.  

The ERR LED on the CPU module 
front panel is green. 

The unit has a message.  Check the Error Logger to 
read message.  

The APPL LED on the CPU 
module front panel is red. 

The user application is not running.  Check the Error 
Logger to read error. 

The CONF LED on the CPU 
module front panel is red. 

There is a configuration error (such as an 
incompatible plug-in.)    Check the Error Logger to 
read error. 

The PWR LED on the CPU module 
front panel is flashing red. 

The boot did not complete and the FPGA is not 
loaded. Download a new system to the unit. 

The PWR LED on the CPU module 
front panel is flashing red. 

The boot did not complete and the FPGA is not 
loaded. Download a new system to the unit. 

The power supply is connected to 
power sources and there is no 
power in AUX1 and/or AUX2. 

Check if the AUX connectors are off due to STS 
Hardware Test.   
 
If not, check if the fuse associated with the AUX is 
burned out and should be replaced.  (One fuse for 
AUX 1A/1B and another fuse for AUX 2A/2B.)  See 
Break-Fix Procedures chapter. 

No communication with WAN, IP 
Gateway.  

Check the unit's connection to the Ethernet.  

 



18-1 

BREAK-FIX PROCEDURES 

General 

 

This chapter refers only to replacement of removable modules and plug-ins, not of 
other components of the unit.  If any other components in the unit require replacement, 
contact your local service center   

Before replacing modules or plug-ins, see safety issues/warnings in the Installation 
chapter above. 

For information on installation of the frame/housing on the wall, see the Installation chapter 
above. 

The ACE3600 has a hot swap capability, which means that the modules can be removed from 
their slots and inserted without powering down the unit.  The only exception to this rule is the 
main power supply module, which cannot be removed during normal operation.   See 
Replacing a Power Supply Module below for details. 

If a module is inserted once the system is running, the system will recognize the module, but 
will not operate it using the application until the unit has been rebooted. 

Replacing a CPU Module 
Procedure 18-1  How to Replace a CPU Module 

1. To replace a CPU module, 
2. Open the door of the CPU module and press the cable holder downward.  
3. Disconnect all cables from the connectors. 
4. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 

module, and pull the module from its slot.  See Figure 18-1. 
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Press Down on 
Module Release Tab

Press Up on Module 
Release Tab  

Figure 18-1  ACE3600 Module Release Tabs 

5. Remove any SRAM plug-in memory from the old CPU module and plug in to the new 
CPU module. 

6. Slide the new module all the way into the slot until the tabs click into place. 
7. Reconnect the cables and press the cable holder back up into place. 

Replacing a Power Supply Module 

 

METAL PARTS OF THE POWER SUPPLY MAY BE VERY HOT. 
After removing the power supply module, allow the metal parts to cool down before 
servicing the unit. 
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Procedure 18-2  How to Replace a Power Supply Module 

1. To replace the second power supply module in a site with redundant power supplies,  
2. Open the door of the power supply module and press the cable holder downward.  
3. Disconnect the cables from the connectors. 
4. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 

module, and pull the module from its slot. 
5. Slide the new module all the way into the slot until the tabs click into place. 
6. Reconnect the cables and press the cable holder back up into place. 
7. The main power supply cannot be removed under power and a safeguard is added in order 

to prevent unplanned removal.  To replace the main power supply module, 
8. Open the door of the power supply module. 
9. Press down on the top of the main power cable connector to disconnect the user’s main 

power cable from the cable inlet on the bottom of the power supply module front panel.   
10. Follow the instructions above for replacing a power supply module. 

Replacing an I/O Module 
Procedure 18-3  How to Replace an I/O Module 

To replace an I/O module, 
1. If the I/O module includes a TB holder, remove TB holder by pulling on the extractor 

handles.  
If the I/O module does not include a TB holder, remove the TBs by hand or using the TB 
extractor. 

2. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 
module, and pull the module from its slot. 

3. Remove any plug-in 24V power supplies from the old I/O module and plug-in to the new 
I/O module. (DI, DO and Mixed I/O modules only.) 

4. For DO relay modules, reset the 12VDO dipswitch, if necessary.  See the Configuration 
chapter. 

5. Slide the new module all the way into the slot until the tabs click into place. 
6. If the I/O module includes a TB holder, reconnect the TB holder as described in the I/O 

Module section.  
If the I/O module does not include a TB holder, replace the TBs on the connectors on the 
front of the I/O module by hand. 

Replacing a Plug-in Port on the CPU Module 
Procedure 18-4  How to Replace a Plug-in Port on the CPU Module 

To replace a plug-in port on the CPU module, 
1. Remove the CPU module from the RTU. 
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2. Unscrew the two supporting pins on the other side of the CPU board.  Save the screws. 

3. Unscrew the two supporting pins on the plug-in port. Save the screws. 

4. Connect the two supporting pins with screws to the new plug-in port. 

5. Replace the plug-in board with the RJ-45 connector facing the panel.  Carefully insert the 
plug-in board connector into the appropriate connector on the CPU board. 
For Ethernet 10/100 MB, use the J14 connector on the CPU (Plug-in 1 only.) 
For all other plug-in ports, use the J5 (Plug-in 1) or J6 (plug-in 2) connector. 

6. Connect the two supporting pins with screws to the other side of the CPU board. 

7. Replace the CPU module in the slot. 

Replacing a Plug-in SRAM Memory Card in the CPU Module 
Procedure 18-5  How to Replace a Plug-in SRAM Memory Card in the CPU Module 

To replace an SRAM memory card on the CPU module, 
1. Remove the CPU module from the RTU. 

2. Remove the old plug-in SRAM memory card from the board.  

3. Place the new plug-in SRAM memory card with the connector facing the panel.  Carefully 
insert the plug-in board connector into the connector marked P12 on the CPU board. 

4. Secure the memory card to the CPU board with the supplied screw. 

5. Replace the CPU module in the slot. 

For more information, see Connecting SRAM Expansion Memory to the CPU Module in the 
CPU Module chapter. 

Replacing the Motherboard 
Procedure 18-6  How to Replace the Motherboard 

To replace the motherboard of the ACE3600 RTU,  
1. If the unit is installed in a NEMA4 housing, unscrew the four large screws and remove the 

metal chassis from the housing. 
2. Remove all modules from the outermost slots, generally the power supply module from the 

leftmost slot and I/O module from the rightmost slot.  
3. Unscrew the M5 screws on each side which secure the motherboard to the metal chassis.  

Save the screws.  See Figure 18-2. 
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Figure 18-2  ACE3600 Motherboard on Metal Chassis 

4. From inside the cage, push out the small cover on the side of the RTU rack/cage.  Save the 
cover. 

5. Slide the damaged motherboard out of the cage, through the opening on the side of the 
RTU rack/cage. 

6. Slide the new motherboard into the rack, through the opening on the side of the RTU 
rack/cage. 

7. Secure the motherboard to the rack/cage and metal chassis using the M5 screws saved in 
step 3. 

8. Replace the cover on the cage. 
9. If the unit was installed in a NEMA4 housing, replace the metal chassis in the housing and 

screw the four large screws from the metal chassis into the housing. 
10. Replace the modules in their respective slots. 
11. Make sure that the ground is reconnected. 
 

Replacing the Fuses on the Power Supply Module for AUX1/AUX2 
Procedure 18-7  How to Replace the Fuse for AUX1 1A/1B or AUX2 2A/2B 

1. To replace a fuse for AUX1 1A/1B or AUX2 2A/2B on the power supply module, 
2. Disconnect cables … from the connectors.  If the faulty fuses are attached to the main 

power supply, press down on the top of the main power cable connector to disconnect the 
user’s main power cable from the cable inlet on the bottom of the power supply module 
front panel.   

3. Simultaneously press on the tabs on the top and bottom of the plastic front of the old 
module, and pull the module from its slot.   
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4. Using narrow pliers, remove the faulty fuse from its groove on the board.   
5. Press the new fuse into the groove on the board. 
6. Slide the power supply module all the way into the slot until the tabs click into place. 
7. Reconnect cables as in installation… 
 

Replacing the Backup Battery on the RTU 
For instructions on replacing the backup battery on the RTU, see Replacing the Backup Battery 
in the Power Supply and Backup Battery chapter above. 

Interconnection Diagrams 
All internal electrical connections except for the main power, ground and battery are performed 
in the factory and supplied with the RTU.  The electrical interconnection diagrams are 
provided below. 

 

Figure 18-3  Electrical Interconnection (RTUs with I/O slots) 
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Figure 18-4  Electrical Interconnection (RTUs with no I/O slots) 
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APPENDIX A: GENERAL SPECIFICATIONS 

Specifications 
The specifications below are for the RTU as a whole.  For the individual technical and 
performance specifications of each module in the RTU, see the specific module chapter. 
 

Table A-1 ACE3600 Specifications 
General   

Frames No I/O slots - PS and CPU modules only, wall mount, 
Dimensions (WxHxD): 117 x 244 x 198* mm (4.61" x 8.23" x 7.80"*), 
Weight: 0.95 Kg (2.1 lb) 
 

3 I/O slots - PS, CPU  and 3 I/O modules, wall mount, 
Dimensions (WxHxD): 234 x 244 x 198* mm (9.21" x 9.61" x 7.80"*), 
Weight: approx. 1.9 Kg (4.19 lb) 
 

5 I/O slots - PS, CPU  and 5 I/O modules, wall mount, 
Dimensions (WxHxD): 314 x 244 x 198* mm (12.36" x 9.61" x 7.80"*), 
Weight: approx. 2.4 Kg (5.3 lb) 
 

7 I/O slots - PS, CPU  and 7 I/O modules; wall mount, 
Dimensions (WxHxD): 391 x 244 x 198* mm (15.39" x 9.61" x 7.80"*), 
Weight: 3.0 Kg (6.6 lb) 
 

8 I/O slots - PS , CPU  and 8 I/O modules, wall mount  or 19" rack,  
Dimensions (WxHxD): 435 x 244 x 198* mm (17" x 9.61" x 7.80"*),  
Weight: approx. 3.3 Kg (7.3 lb) 

* Depth including Module panel  

Metal Chassis Large  - for PS, CPU and up to 7 I/O slot frame, two radios and 6.5 or 10 
Ah backup battery, wall mount ,  
Dimensions (WxHxD): 448 x 468 x 200* mm (17.64"x 18.43"  x  7.88"*) 
 

Small  - for PS, CPU and up to 3 I/O slot frame, one radio and 6.5  Ah 
backup battery, wall mount,  
Dimensions (WxHxD): 335 x 355 x 198* mm (17.64" x 18.43"  x  7.80"*) 

* Depth including Frame and Module  



Appendix A: Specifications 

A-2 

Enclosures Large Nema 4X / IP65 painted metal -  up to 7 I/O slot frame, two radios 
and 6.5 or 10 Ah, backup battery,  
Dimensions (WxHxD): 500 x 500 x 210 mm (19.7" x19.7" x 8.26" ) 
 

Small Nema 4X / IP65 painted metal -  up to 3 I/O slot frame one radio and 
6.5 Ah backup battery,  
Dimensions (WxHxD): 380 x380 x 210 mm (15" x 15" x 8.26") 

Power Supply  10.5-16 V DC (default) 

18-72 V DC 

18-72 V DC with 12V smart battery charger 

85- 264 V AC, 50-60 Hz  

85- 264 V AC, 50-60 Hz,  with 12V smart battery charger 

Backup Battery 6.5 Ah - Sealed Lead-Acid 

10 Ah  - Sealed Lead-Acid 

Operating Temperature -40 ºC to +70 ºC (-40 ºF to 158 ºF)  

Storage Temperature -55 ºC to +85 ºC (-67 ºF to 185 ºF)  

Operating Humidity 5% to 95% RH @ 50 ºC without condensation  

Mechanical Vibrations  Per EIA / TIA 603 Base-station, Sinusoidal 0.07mm @ 10 to 30 Hz, 0.0035 
mm @ 30-60 Hz  

Operating Altitude -400m to +4000 meter (-1312  ft to + 13120 ft) above sea level 
  
Regulatory Standards  

Safety UL 60950-1 (UL listed), CSA 22.2-950-1, EN60950-1, IEC 60950-1, 
AS/NZS 60950  

Emission Emission standards for industrial environments  

CFR 47 FCC part 15, subpart B (class A);  
CE EMC: EN50081-2/EN61000-6-4  

(CISPER 11 / EN55011 class A) 

Immunity Immunity standards for industrial environments  

Per EN50082-2 /IEC 61000-6-2   

 

Communications  

Communication Ports  Up to 5 Ports per CPU 

Serial - up to 4 x RS232 ports 

Multi-drop – up to 3 x RS485 port 

Ethernet - up to 2 x 10/100 MB ports and 1 x 10 MB  

Two-way radio / analog trunked radio - up 2 x  modem ports  
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Motorola Radio Support Mobile two-way radios  –  CM 200 , CM 340, GM 3188, EM 200, 
CDM750 

Portable two-way radios – HT750, GP320,  GP328, PRO5150 

Astro radios  – XTL 5000 (digital and analog trunked) , XTS 2500 
(digital trunked) 

Dimetra radios – MTM 800 (PD) 

Third Party Radio Support Two-way radios, Data radios, TETRA radios (PD)  

Modem Support  Dial-up modems, Cellular modems (dial mode and PD) 

Protocols MDLC, TCP, UDP, IP, PPP, NTP, DHCP   

Third Party Protocols Modbus RTU (Master/Slave, RS232/RS485),  
DF1 (Allan Bradley – Master RS232) 

User Protocol (in user program) Possible on RS232, RS485 and Ethernet ports  
 

Specifications subject to change without notice. 
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APPENDIX B: ENVIRONMENTAL PROTECTION 

Disposal of Components 
All components of the ACE3600 should be properly disposed of, in accordance with local 
regulatory standards and laws. 

All ACE3600 models comply with RoHS European Directive no. 2002/95/EC (Restriction of 
the use of Hazardous Substances) and WEEE Directive no. 2002/96/EC (Strategy of Waste 
management), with the exception of models which are equipped with an XTL5000 radio 
(F7523A/F7513A/F7524A/F7514A/F7585A/F7586A), or with a CDM750 radio (F7563A/ 
F7564A)  
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APPENDIX C: RS232/RS485 ADAPTOR CABLES 

General 

 
Note: On all of the Motorola RJ45 connector heads, the numbering of the pins is 
different than the standard, as shown in the figure below.  Pin 1-8 are left to right 
rather than right to left, as shown below.  Therefore, only original Motorola cables 
should be used. 

                           
 
This appendix provides the information required for connecting an RTU RS232 port to various 
units, as detailed below: 

• Connection to a computer/terminal (MDLC protocol or User port) 
• Connection to a modem (MDLC protocol or User port) 
• Connection to the GPS receiver (MDLC protocol) 
• Connecting a User port to a printer 
• Connecting a User port to an external unit 
• Connection to a radio (MDLC protocol) 
• RTU-to-RTU connection using MDLC protocol through RS232 ports (RS-Link) 
• ACE3600 RTU-to-MOSCAD RTU connection using MDLC protocol through RS485 ports 

(RS-Link) 

Connection to a Computer or Terminal 
To connect one of the RTU RS232 ports to a computer/terminal, use the FLN6457B adaptor, 
which ends with the female 25-pin or 9-pin, D-type connector. The port may be defined either 
as a MDLC protocol port or as a User port. 
The signals that appear on the female 25-pin or 9-pin D-type connector are according to the 
RS232 standard – see the following table. In this case, the RTU serves as DCE (Data 
Communication Equipment). 

RS232 Function 8-pin 
Connector (on 
RTU) 

25-pin Female 9-pin Female Direction 

TX-DATA 2 ← 2 3 from DTE 

RX-DATA 1 → 3 2 to DTE 
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RS232 Function 8-pin 
Connector (on 
RTU) 

25-pin Female 9-pin Female Direction 

RTS 5 ← 4 7 from DTE 

CTS 8 → 5 8 to DTE 

DSR 7 → 6 6 to DTE 

GND 4 7 5 - 

DTR 3 ← 20 4 from DTE 

DCD (Rec line) 6 → 8 1 to DTE 
 
To extend the cable, you may use any extension cable with male and female D-type connectors 
(connected pin-to-pin, not crossed). 
Note: When a User port is defined as Computer/Terminal with DTR support: 
The RTU will not transmit unless it receives DTR=ON from the computer/terminal. 
The RTU will not receive unless it receives RTS=ON from the computer/terminal. 

Connection to a Modem 
To connect one of the RTU RS232 ports to an RS232 modem, use one of the adaptors provided 
in kit FLN6458B (option V213AE): 

• 9-pin adaptor for Async (#0189968V32) 
• RS232-E adaptor (#0189968V33) as in Connection to IDEN Radio below. 
• RS232-E+ adaptor (#0189968V34) as in Connection to TETRA Radio below. 
The asynchronous adaptor (#0189968V32) ends with the male 9-pin D-type connector. The 
port may be defined either as a MDLC protocol port or as a User port. 
The signals that appear on the male 9-pin D-type (or 25-pin) connector are according to the 
RS232 standard – see the following table. In this case, the RTU serves as DTE (Data Terminal 
Equipment). 

RS232 Function 8-pin 
Connector(on 
RTU) 

25-pin Male 9-pin Male Direction 

TX-DATA 1 → 2 3 from RTU 

RX-DATA 2 ← 3 2 to RTU 

RTS 6 → 4 7 from RTU 

CTS 3 ← 5 8 to RTU 

GND 4 7 5 - 

DTR 8 → 20 4 from RTU 

DCD (Rec line) 5 ← 8 1 to RTU 
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To extend the cable, you may use any extension cable with male and female D-type connectors 
(connected pin-to-pin, not crossed). 
Before transmitting, the RTU sends RTS=ON to the modem, and waits for CTS=ON from the 
modem as a condition for transmitting. 
The RTU will receive data from the modem only when DCD=ON. 
When using a modem in auto-answer mode (connected to a Computer port) for remote service, 
the RTU does not support RTS/CTS protocol since the port is designated to operate with a 
local computer as well as with a modem. 
For modems which support RS232-E, use either the RS232-E adaptor (#0189968V33) as in 
Connection to IDEN Radio below, or the RS232-E+ adaptor (#0189968V34), as in Connection 
to TETRA Radio below. 

Connection to GPS Receiver 
When an off-the-shelf GPS timing receiver is purchased (e.g. Synergy SynPaQ/E PPS Sensor 
with M12+), the data and power cable for that receiver should be purchased as well.   
Connect the data wire of the cable to the CPU port using the ACE3600 asynchronous RS232-E 
adaptor cable.  The port should be defined as a GPS receiver port (RS232, Async). 
Connect the power wire of the cable to a cable with the following connectors: 
RTU side: The connector should fit the auxiliary power connector on the ACE3600 power 
supply module. 
GPS Receiver side: The connector should fit the power connector on the GPS receiver cable. 

Connecting a User Port to a Printer 
To connect one of the RTU RS232 ports defined as a User port to a printer, you may use one of 
the two cables described in the previous paragraphs. Since the connection to the printer is not 
defined by the RS232 standard, every printer manufacturer has defined the connectors for his 
own convenience. Therefore, select the adaptor according to the functions of the various pins. 
If the FLN6458B adaptor (with the male 9-pin D-type connector) is used, refer to the following 
table. 

RS232 Function 9-pin Male Used as Direction 

TX-DATA 3 Serial Data to Printer 

CTS 8 Printer Ready from Printer 

GND 5 GND - 
 
If the FLN6457B adaptor (with the female 9-pin, D-type connector) is used, refer to the 
following table. 

RS232 Function 9-pin Female Used as Direction 

RX-DATA 2 Printer Rx-Data to Printer 

DTR 4 Printer Ready from Printer 

GND 5 GND - 
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Connecting a User Port to an External Unit 
To connect one of the RTU RS232 ports defined as a User port to an external unit (which 
supports RS232), you may use one of the two adaptors (FLN6457B or FLN6458B) according 
to the port definition in the site configuration. 
If the FLN6457B adaptor is used, refer to the pin assignment given in Connection to a 
Computer or Terminal in this chapter. 
If the FLN6458B adaptor is used, refer to the pin assignment given in Connection to a Modem 
in this chapter. 

Connection to a Radio 
For detailed instructions on connecting a radio to the ACE3600 RTU, see the Radio Types and 
Installation Kits chapter above.  

Connection to IDEN Radio 
To connect the RTU (via onboard serial or plug-in port) to an IDEN radio, use an adaptor 
which ends with the male 9-pin, D-type connector. The port should be defined as RS-232, 
Async, PPP, iDEN, MDLC over IP. 

RS232 Function 8-pin Connector(on 
RTU) 

9-pin Male Direction 

TX-DATA 1 → 3 from RTU 

RX-DATA 2 ← 2 to RTU 

CTS 3 ← 8 to RTU 

GND 4  5 - 

CD (Rec line) 5 ← 1 to RTU 

RTS  6 → Not used  

  7 → 4 from RTU 

DTR  8 → 7 from RTU 
 

Connection to TETRA Radio 
To connect the RTU (via onboard serial or plug-in port) to a TETRA radio, use an RS232-E+ 
type adaptor which ends with the male 9-pin, D-type connector. The port should be defined as 
RS232, Async, PPP, Tetra, MDLC over IP. 

RS232 Function 8-pin Connector(on 
RTU) 

9-pin Male Direction 

TX-DATA 1 → 3 from RTU 

RX-DATA 2 ← 2 to RTU 

CTS 3 ← 8 to RTU 



Appendix C: RS232/RS485 Adaptor Cables 

C-5 

RS232 Function 8-pin Connector(on 
RTU) 

9-pin Male Direction 

GND 4  5 - 

CD (Rec line) 5 ← 1 to RTU 

RTS  6 → 4 from RTU 

  7  Not used  

DTR  8 → 7 from RTU 
 

RTU-to-RTU Connection Using MDLC Protocol through RS232 
To establish a link between two RTUs using MDLC protocol, the ports of both RTUs should 
be defined as RS232 RTU-to-RTU (RS-Link). The ports of the two RTUs should be connected 
by the FLN6457B and FLN6458B adaptors, when the adaptors are connected. 

 
Do not connect between RTUs without the adaptor cables. A direct connection will cause a 
short circuit between the pins that have the same function. 

RTU-to-RTU Synchronous Communication Using Plug-in Port 
The pin assignment of the cable to be used for RTU-to-RTU synchronous communication 
(using a plug-in port) is given below. 
 

RS232 Function 8-pin Connector 
(on sending RTU) 

8-pin Connector 
(on receiving RTU) 

Direction 

TX-DATA 1 → 2 ← from RTU 

RX-DATA 2 ← 1 → to RTU 

CTS 3 +6 →∗ 5 ← from RTU 

Signal GND 4  4  - 

CD (Rec line) 5 ← 3 +6 →∗ to RTU 

RTS  6 +3 →∗ 5 ← from RTU 

TX_CLK  7 → 8 ← from RTU 

RX_CLK 8 ← 7 → to RTU 
 
*Pins 3 and 6 are shorted. 
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ACE3600 RTU-to-MOSCAD RTU Connection Using MDLC Protocol 
through RS485 

To establish a link between an ACE3600 unit and a MOSCAD RTU using MDLC protocol, the 
ports of both RTUs should be defined as RS485 RTU multidrop. The ports of the two RTUs 
should be connected using the 3089004V58 cable. 

 
Do not connect between RTUs without the adaptor cables. A direct connection will 
cause a short circuit between the pins that have the same function. 

 

RS485 Function 8-pin 
Connector 
(on ACE3600) 

4-pin  
Connector (on 
MOSCAD) 

B (RX/TX-) 1  2 

A (RX/TX+) 8  3 
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